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Kata Pengantar 
 

Puji syukur kami panjatkan ke hadirat Allah SWT, atas segala rahmat, hidayah, dan karunia-

Nya, yang telah melimpahkan berkah dan kekuatan bagi kami untuk menyelesaikan modul 

ini. Dengan penuh rendah hati, kami merasa terhormat dapat mempersembahkan modul 

berjudul "Perancangan Desain Sistem Menggunakan Balsamiq" kepada para pembaca yang 

budiman. modul ini merupakan hasil dari proses menyadur dokumentasi resmi dari tool 

balsamiq. 

 

Modul "Perancangan Desain Sistem Menggunakan Balsamiq" ini dirancang dengan tujuan 

untuk memberikan panduan yang jelas dan terperinci bagi para pembaca dalam merancang 

sistem yang berkualitas tinggi. Dengan semakin kompleksnya kebutuhan pengguna dalam 

dunia teknologi informasi, merancang sistem yang sesuai dengan kebutuhan dan harapan 

pengguna menjadi tantangan yang harus dihadapi oleh para desainer sistem. Oleh karena 

itu, dalam modul ini, kami berusaha memberikan panduan praktis tentang bagaimana 

memahami kebutuhan pengguna, merancang interaksi yang intuitif, dan menyusun tata letak 

yang baik dengan menggunakan Balsamiq sebagai alat bantu utama. 

 

Dalam menyusun modul ini, kami mengusahakan untuk menyajikan informasi secara 

sistematis dan terstruktur agar dapat dengan mudah dipahami oleh pembaca dari berbagai 

latar belakang keilmuan. modul ini terdiri dari beberapa bab yang membahas langkah-

langkah penting dalam proses perancangan sistem, mulai dari pemahaman kebutuhan 

pengguna, analisis kebutuhan, perancangan wireframe, hingga uji coba dan evaluasi.  

 

Kami menyadari bahwa modul ini tidak lepas dari keterbatasan dan kekurangan. Oleh karena 

itu, kritik, saran, dan masukan dari para pembaca sangat kami harapkan guna 

menyempurnakan isi modul ini di masa mendatang. Kami berharap modul "Perancangan 

Desain Sistem Menggunakan Balsamiq" ini dapat memberikan kontribusi yang berarti bagi 

perkembangan teknologi informasi dan dunia desain sistem. Terakhir, tak lupa kami 

sampaikan rasa terima kasih yang tulus kepada semua pihak yang telah membantu dan 

mendukung kami dalam menyelesaikan modul ini, baik secara langsung maupun tidak 

langsung. 

 

Semoga modul ini dapat bermanfaat dan menjadi referensi yang berharga bagi para 

profesional, mahasiswa, akademisi, dan pihak-pihak yang tertarik dalam bidang 

perancangan sistem. Selamat membaca, dan semoga ilmu yang diperoleh dari modul ini 

dapat diterapkan dengan bijaksana dalam berbagai proyek perancangan sistem di masa 

depan.  
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Balsamiq Mockups 3 Application Overview → 

 

 

Pengantar Balsamiq Mockups 3 
 

 

 

Balsamiq Mockups 3 adalah hasil dari hampir satu tahun pengkodean head-down 

untuk menciptakan produk yang diminta pelanggan kami dan produk yang kami 

inginkan untuk diri kami sendiri. 

 

Perubahan yang paling mencolok adalah dua "biggies" yang diminta orang sejak 

awal: Dukungan untuk proyek (file yang dibundel, banyak jendela) dan 

menyingkirkan "properti mengambang" (inspektur properti). 

 

Tetapi yang sama pentingnya adalah pekerjaan yang dilakukan di bawah tenda 

untuk membuatnya lebih cepat dan lebih pintar dan sedikit penyesuaian di setiap 

bagian dari pengalaman yang kami harap akan membuatnya lebih baik. 

 

Dalam artikel ini Anda akan menemukan informasi tentang  cara memperbarui, 

apa yang baru dan, tentu saja, cara mengimpor file BMML Mockups 2 Anda . Jika 

Anda baru mengenal Balsamiq Mockups atau ingin menyelam lebih dalam setelah 

membaca artikel ini, Anda dapat menuju ke daftar isi dokumentasi atau ikhtisar 

aplikasi berikutnya. 

https://balsamiq.com/wireframes/desktop/docs/
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Cara Memperbarui 
Balsamiq Mockups 3 adalah versi terbaru dari editor kami yang kuat. Jika Anda 

menggunakan salah satu aplikasi web kami, itu akan diperbarui secara otomatis. 

Jika Anda ingin menggunakannya di Desktop, Anda dapat mengambil versi 

terbaru dari halaman unduhan kami. Ini adalah pembaruan gratis untuk 

pelanggan yang sudah ada, Anda bahkan tidak perlu mendaftar ulang. 

 

Balsamiq Mockups 3 untuk Desktop akan berjalan berdampingan dengan 

Balsamiq Mockups 2 untuk Desktop (sebagai aplikasi terpisah) sehingga tidak 

perlu menghapus versi Anda saat ini untuk menggunakannya. Lihat di bawah 

untuk cara mengimpor file Mockups 2 BMML. 

 

Meskipun telah diuji secara ketat, jika Anda menemukan bug atau masalah, beri 

tahu kami tentang hal itu! 

 

 

Apa yang Baru di Balsamiq Mockups 3 
Singkatnya, banyak! Berikut adalah "sorotan" yang harus Anda ketahui: 

 

Proyek! 

Antarmuka pengguna baru 

Kustomisasi tampilan dan nuansa yang lebih mudah  

Simbol yang lebih baik 

Ikon yang lebih baik 

Gambar dan aset yang lebih baik Mode layar penuh 

Catatan Sampah Bergantian Musik??? 

 

Proyek! 

Akhirnya. Anda tidak hanya dapat memiliki jendela terpisah untuk berbagai 

kelompok mockup, tetapi semua "barang" milik proyek (mockup, simbol, 

gambar, ikon) ada dalam SATU file. Ini membuatnya lebih mudah untuk 

mengirim dan memindahkan file dan menyatukan semuanya. 

https://balsamiq.com/wireframes/desktop/
mailto:support@balsamiq.com
mailto:support@balsamiq.com
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Antarmuka Pengguna Baru 

Lewatlah sudah inspektur properti terbang yang menyebalkan! Sekarang Anda 

memiliki maket di sebelah kiri dan properti di sebelah kanan. Sederhana, dapat 

diprediksi, dan cepat. Perpustakaan UI berada di bagian atas di mana selalu 

tetapi sekarang sedikit lebih kompak. 

 

 
 

 

Anda dapat beralih panel properti dan Perpustakaan UI secara independen 

dengan mengklik ikon di sebelah kotak Tambah Cepat atau melalui pintasan 

keyboard. 

 

 

 

 

Dan, tentu saja, Anda dapat menyembunyikan semua panel menggunakan ikon 
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untuk setiap panel, membawa Anda ke nirwana wireframing seperti Zen. 

 
 

 

Berkeliling dan melakukan tindakan umum mudah dilakukan dengan ikon di 

bilah alat. 

 

 

 

 

1. Menavigasi antara tampilan Mockup, Aset, Simbol, dan Tong Sampah 

2. Tampilkan/Sembunyikan panel kiri 

3. Menampilkan mockup Anda sebagai kisi thumbnail 

4. Membuat mockup baru 

5. Tindakan mockup (ganti nama, dll.) dan menavigasi di antara mockup 

(ditampilkan saat panel kiri disembunyikan) 
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6. Masuk ke mockup berikutnya atau sebelumnya (ditampilkan saat panel kiri 

disembunyikan) 

 

Kustomisasi Tampilan dan Nuansa Lebih Mudah 

Kontrol atas font yang digunakan dalam Mockup telah menjadi salah satu fitur 

yang paling banyak diminta sejak itu awal. Font kustom sebelumnya tersedia 

menggunakan file konfigurasi yang rumit, tetapi sekarang kami mengizinkan 

Anda untuk mengatur font proyek di panel Info Proyek baru. Ya, Anda sekarang 

dapat dengan mudah menggunakan font apa pun yang telah Anda instal di mockup 

Anda. Bersukacita! Anda juga dapat mengatur ukuran default untuk itu. 
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Kami juga memindahkan opsi peralihan kulit ke panel Info Proyek baru untuk 

membuatnya lebih jelas (banyak orang tidak pernah tahu tentang kulit wireframe 

kami). Akhirnya, warna pemilihan default juga dapat dikonfigurasi dari panel 

baru ini. 

 

Simbol yang Lebih Baik 

Dalam versi sebelumnya, kami menyebut Simbol sebagai "fitur lanjutan." Yah, 

tidak lagi. Simbol sekarang untuk semua orang. Simbol memungkinkan Anda 

membuat templat, master, dan komponen lain yang dapat digunakan kembali 

untuk menghemat waktu dan memastikan konsistensi. Mereka sangat berguna 

untuk proyek-proyek besar dan kontrol khusus dan merupakan pusat situs 

Wireframes To Go  kami. 

 

Anda sekarang dapat melompat ke panel Simbol dan membuat yang baru dari 

awal dan itu akan muncul di tab "Simbol" di Perpustakaan UI. Anda masih dapat 

membuatnya dengan cara kuno (membuat grup bernama dan mengklik tombol 

"Ubah Menjadi Simbol"). 

 

 

 

 

Kami juga sekarang menampilkan Simbol sebagai daftar di dalam Perpustakaan 

Simbol mereka, sehingga Anda dapat lebih mudah menavigasi di antara mereka 

dan mengetahui Simbol mana yang Anda edit. 

https://balsamiq.com/wireframes/desktop/docs/skins
https://balsamiq.com/wireframes/desktop/docs/skins
https://wireframestogo.com/
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Akhirnya, kami membuatnya lebih mudah untuk mengimpor Simbol. Cukup klik 

ikon "Impor Perpustakaan Simbol" dan pilih file yang akan diimpor. 
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Ikon yang Lebih Baik 

Perubahan besar di sini. 

 

Pertama-tama, ikon sekarang memiliki kategori sendiri di Perpustakaan UI 

sehingga Anda dapat menarik dan melepaskannya seperti kontrol lainnya. 

 

 

 

 

Tidak hanya itu, mereka muncul di hasil Quick Add, menghemat waktu Anda saat 

mencari berdasarkan nama atau kata kunci. 

 
 

 

Hasil penelusuran ikon ditampilkan di bawah kontrol UI apa pun yang cocok 

dengan teks yang Anda masukkan. 

 

Dan Anda akan segera melihat bahwa kami memiliki serangkaian ikon yang sama 

sekali berbeda dari versi sebelumnya. Kami mengalihkan ikon kami ke set ikon 



Halaman | 10 

 

Font Awesome  yang sangat populer. Ini berarti bahwa sekarang ada lebih dari 

500 ikon pra-instal. 

 

Gambar dan Aset yang Lebih Baik 

Sekarang ada area khusus untuk gambar dan aset impor lainnya, dapat diakses 

dari menu navigator. 

 

 

 

 

Anda dapat menambahkan gambar ke proyek Anda tanpa menempatkannya di 

mockup Anda terlebih dahulu. Klik tombol "Impor Aset..." untuk menambahkan 

file dari komputer atau ikon "Download Aset..." untuk menambahkan gambar 

dari Flickr atau web. Atau cukup seret gambar ke kanvas dari komputer. 

 

 

 

 

Anda juga dapat menghapus, mengganti nama, mengganti, dan mengunduh 

gambar dari menu konteks di panel. 

 

http://fortawesome.github.io/Font-Awesome/
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Mode Layar Penuh Baru 

Opsi yang sama masih ada tetapi kami telah merombak pengalaman untuk 

membuatnya lebih baik untuk pengujian kegunaan dan presentasi. Kami juga 

menyingkirkan masalah di mana maket akan "melompat-lompat" dalam mode 

layar penuh. 
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Catatan 

Jika tidak ada kontrol yang dipilih, Anda akan melihat tempat untuk 

menambahkan catatan di panel Properti. Anda dapat menambahkan catatan 

untuk Proyek, Maket, Aset, Pustaka Simbol, dan Simbol individual Anda dan 

mereka akan disimpan sebagai bagian dari proyek. 
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Sampah 

Balsamiq Mockups 3 sekarang memiliki sampah untuk maket, aset, dan Simbol 

yang telah Anda hapus. Ini memudahkan untuk menjaga proyek Anda tetap rapi 

saat Anda membuat kemajuan tetapi masih memungkinkan Anda untuk 

menelusuri atau memulihkan konsep sebelumnya. 

 
 

 

Untuk memulihkan objek yang dibuang dari panel Tong Sampah, klik panah 

menu konteks dan pilih "Pulihkan." Anda juga memiliki opsi untuk menghapus 

secara permanen. 

 

 

 
 

Cadangan 

Alternatif (juga kadang-kadang disebut sebagai versi atau cabang) 

memungkinkan Anda untuk membuat variasi pada desain mockup tunggal tanpa 

menambahkan lebih banyak mockup ke proyek Anda. Baca dokumentasi 

lengkapnya di sini. 
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Musik??? 

Ya, musik latar bawaan untuk membantu Anda masuk ke zona kreatif Anda! Lihat 

posting blog untuk lebih jelasnya. 

 

 

 

 

 

Apa yang tidak baru 

Untuk sebagian besar, kami meninggalkan pengalaman menambahkan, 

https://blog.balsamiq.com/3-1/
https://blog.balsamiq.com/3-1/
https://blog.balsamiq.com/3-1/
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mengatur, dan mengedit kontrol yang sama, jadi seharusnya sudah tidak asing 

lagi jika Anda berasal dari versi sebelumnya. 

Kami berharap semua perubahan ini disambut baik dan Balsamiq Mockups 3 

masih terasa seperti aplikasi yang Anda kenal dan sukai, tetapi lebih baik! Jika 

Anda memiliki pemikiran atau umpan balik, 

 

Beri tahu kami! 

 

 

Mengimpor Mockup 2 File BMML 
Balsamiq Mockups 3 memiliki format file baru untuk mengakomodasi dukungan 

untuk proyek tetapi Anda dapat dengan mudah mengimpor file lama Anda. 

 

Untuk mengonversi folder proyek atau file ZIP yang ada menjadi file BMPR, cukup 

buka Project > Menu impor. 
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Balsamiq Mockups 3 Application Overview → 

 

 

Pilih apa yang ingin Anda impor dan file lama Anda akan diimpor dan file BMPR 

baru akan dibuat. 

 
 

 

 

Umpan Balik Selamat Datang 
Kami ingin tahu pendapat Anda tentang hal itu. Jika Anda menemukan masalah 

atau memiliki komentar, jangan ragu untuk mengirim email kepada kami atau 

memposting Forum Balsamiq. Sampai jumpa di sana! 

 

 

mailto:support@balsamiq.com
https://forums.balsamiq.com/


Halaman | 17 

 

← Introduction to Balsamiq Mockups 3 

Sharing in Balsamiq Mockups 3 for Desktop → 

Note: Single project files are new in Balsamiq Mockups 3. 

 
 

Balsamiq untuk Dokumentasi Desktop 
 
 

 
 

Balsamiq untuk Dokumen Desktop > Ikhtisar Aplikasi Balsamiq Mockups 3 

 

Balsamiq Mockups 3 Ikhtisar Aplikasi 
 

 

 

Balsamiq Mockups adalah alat desain antarmuka pengguna untuk membuat 

wireframes (juga disebut mockup atau prototipe low-fidelity). Anda dapat 

menggunakannya untuk menghasilkan sketsa digital dari ide produk Anda untuk 

memfasilitasi diskusi dan pemahaman sebelum kode apa pun ditulis. 

 

Setiap file Balsamiq Mockups (dengan ekstensi file .bmpr) mewakili satu proyek 

dan dapat berisi banyak mockup dan gambar, yang disimpan bersama dalam 

satu file .bmpr. 

Mockup untuk proyek yang berbeda harus dibuat dalam file Balsamiq Mockups 

terpisah. Untuk membuat proyek baru, pilih Project > New Project dari menu. 

 

 

Antarmuka pengguna Balsamiq Mockups terdiri dari lima area utama: toolbar, 

https://balsamiq.com/wireframes/desktop/docs/intro/
https://balsamiq.com/wireframes/desktop/docs/intro/
https://balsamiq.com/wireframes/desktop/docs/
https://balsamiq.com/learn/resources/articles/what-are-wireframes/


Halaman | 18 

 

Note: You can watch a video covering basic usage of the application in our Mockups 

Intro Video tutorial. 

Perpustakaan UI , kanvas,  panel navigator, dan panel properti  . Masing-masing 

dijelaskan di bawah ini. 

 
 

 

 

 

The Toolbar 
Toolbar berisi serangkaian ikon untuk melakukan tindakan pada area lain dari 

antarmuka pengguna. 

 

Set ikon pertama dijelaskan di bawah ini. 

 

 

https://balsamiq.com/wireframes/desktop/docs/intro/
https://balsamiq.com/wireframes/desktop/docs/intro/
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1. Menavigasi antara Mockup, Aset, Simbol, dan  Tong Sampah 

2. Tampilkan/Sembunyikan panel kiri 

3. Menampilkan mockup Anda sebagai kisi thumbnail 

4. Membuat mockup baru 

5. Tindakan mockup (ganti nama, dll.) dan menavigasi di antara mockup 

(ditampilkan saat panel kiri disembunyikan) 

6. Masuk ke mockup berikutnya atau sebelumnya (ditampilkan saat panel kiri 

disembunyikan) 

 

Grup ikon di tengah toolbar adalah untuk fungsi kanvas yang umum dilakukan . 

Ini adalah tindakan yang mungkin biasa Anda lakukan dari editor teks atau alat 

menggambar lainnya, seperti salin, tempel, kelompokkan, ratakan, dan perbesar. 

Ikon terakhir adalah untuk toggling markup (baca tentang markup di sini). 

 

 

 

 

Bagian terakhir dari toolbar di paling kanan berisi alat Quick Add, ikon toggle  

untuk Perpustakaan UI, Inspektur Properti  dan Panel Info Proyek, dan ikon untuk 

masuk ke Mode Presentasi Layar Penuh.    

 

 

 

 

Bagian atas toolbar menunjukkan nama proyek, yang dapat Anda klik dua kali 

untuk mengganti nama (atau pergi ke Project > Rename Project... di menu). 

 

 

https://balsamiq.com/wireframes/desktop/docs/controls#grouping-ui-controls
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Alat Tambah Cepat 
Alat Tambah Cepat adalah cara tercepat untuk menambahkan kontrol UI ke 

mockup Anda. Untuk menggunakan penambahan cepat, Klik di dalam kotak 

input tambah cepat (atau gunakan pintasan keyboard / atau + untuk 

memasukkannya). Ketik beberapa huruf dari nama kontrol atau ikon UI dan 

Quick Add akan menampilkan daftar saran. Gunakan tombol mouse atau panah 

Anda untuk menggulir ke bawah daftar dan klik atau tekan Enter untuk 

menambahkan kontrol atau ikon pada kanvas mockup. Anda juga dapat 

menggunakan Shift + Enter untuk menempatkan kontrol di mana kursor mouse 

Anda berada di kanvas. 

 

Misalnya, mengetik "bu" menunjukkan daftar yang berisi "Tombol", "Tombol Bar", 

"Tombol Bantuan", "Tombol Radio" dan "Tombol Bulat". Mengetik "hel", di sisi 

lain, hanya mengembalikan "Tombol Bantuan". 

Menekan tombol ESCape membuat daftar menghilang, seperti yang diharapkan. 
 

 

 

 

Cobalah Quick Add sekarang! Saat Anda terbiasa dengannya, Anda bahkan dapat 

menyembunyikan Perpustakaan UI dan cukup menggunakan Quick Add untuk 

menambahkan elemen UI ke mockup Anda. Ini memaksimalkan area kanvas 

mockup Anda dan kecepatan Anda! 
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Perpustakaan UI 
UI Library, atau UI controls Library, adalah strip panjang kontrol UI tepat di 

bawah toolbar. Ini mencantumkan semua jenis kontrol UI yang datang dengan 

Mockup serta Aset, Ikon, dan Simbol. Tujuan utama Perpustakaan UI adalah 

memungkinkan Anda menambahkan kontrol UI ke kanvas mockup, tetapi Anda 

juga dapat menggunakannya untuk melihat apa yang mungkin dan mendapatkan 

inspirasi untuk mockup UI Anda. 

 

 
 

 

Untuk menambahkan kontrol UI baru ke kanvas, pilih jenis kontrol yang ingin 

Anda tambahkan lalu seret ke kanvas mockup di bawah ini atau cukup klik dua 

kali dan Balsamiq Mockups akan menempatkannya di kanvas mockup untuk 

Anda. 

 

Perpustakaan UI dapat diaktifkan dan dinonaktifkan dengan beberapa cara: 

mengklik ikon di sebelah kanan kotak Tambah Cepat, menggunakan pintasan 

keyboard CTRL/CMD+L, atau dengan memilih Lihat Perpustakaan UI > dari menu 

aplikasi. 

 

 

Kanvas Mockup 
Ini adalah area kerja utama Balsamiq Mockups, tempat mockup UI Anda menjadi 

hidup. Setelah Anda menambahkan kontrol UI ke dalamnya, Anda dapat 

memindahkannya, mengubah ukurannya dan menyesuaikannya sesuka hati Anda 

sampai mockup UI Anda siap. Lihat Bekerja dengan Kontrol UI untuk mempelajari 

lebih lanjut. 

 

Kanvas mockup tumbuh dan menyusut dengan jendela aplikasi Anda, sehingga 

Anda dapat memberi ruang untuk mockup yang lebih besar jika perlu. 
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Note: If you are working on a small screen or have very large mockups you might want 

to read this article on hiding the panels to make more room for the canvas. 

 

Ukuran maksimum untuk setiap kanvas wireframe di Balsamiq Mockups 3 adalah 

4056x4056 piksel. Jika wireframe Anda menabrak ukuran kanvas maksimum, 

Anda dapat mencoba menggunakan breakline untuk menunjukkan kelanjutan. Ini 

adalah sesuatu yang sering dilakukan desainer dalam spesifikasi wireframe. 

Mockup mendukung breakline di kontrol Browser, Rectangle, Geometric Shape 

dan Horizontal Rule. 

 

 
 

 

 

 

The Navigator Panel 
Panel navigator di sebelah kiri menampilkan daftar mockup, aset, atau Simbol 

dalam proyek Anda. Objek yang saat ini dipilih disorot. Anda dapat memilih 

beberapa objek di panel navigator dengan menahan tombol Control atau Shift 

dan mengkliknya. Mockup dan aset dapat dilihat sebagai daftar teks saja atau 

sebagai pratinjau thumbnail. 
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Anda dapat menyembunyikan panel navigator dengan mengklik ikon sakelar 

navigator di atas panel (pintasan keyboard: CTRL/CMD + J). Menyembunyikannya 

akan menampilkan ikon tambahan di bilah alat (ditunjukkan di atas) untuk 

menavigasi antara maket atau aset (tergantung mana yang dipilih). Panel dapat 

diubah ukurannya dengan menempatkan kursor mouse Anda di atas garis yang 

memisahkan panel navigator dari kanvas dan menyeret ke kiri atau kanan. Anda 

dapat mengklik dua kali pada garis pemisah untuk mengatur ulang ke lebar 

default. 

 

Anda dapat berpindah di antara mockup atau aset menggunakan keyboard Anda 

melalui CTRL + Tab atau dengan mengklik salah satu di navigator dan 

menggunakan tombol panah atas dan bawah. 

 

Maket dapat disusun ulang dengan menyeretnya ke atas dan ke bawah di panel 

navigator. Ini dapat berguna saat mengekspor ke PDF, misalnya. Urutan maket 

Anda akan diingat ketika Anda menutup dan membuka kembali proyek Anda, 

bahkan jika dibuka di komputer yang berbeda. 
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Menggunakan Mockup Hierarchy 

Mockups 3 untuk editor / b3 juga menawarkan struktur hierarkis untuk 

mengatur mockup Anda dengan lebih baik. 

 

Untuk menggunakannya, pilih mockup yang Anda inginkan untuk menjadi anak 

dan tekan tombol Tab. Mockup anak akan ditempatkan dalam hierarki pohon di 

bawah mockup di atasnya. 

 

Anda kemudian dapat menggunakan panah di sebelah kiri mockup induk untuk 

menampilkan dan menyembunyikan mockup di bawahnya. 

 

 

 

 

Untuk memulihkannya ke tingkat atas, gunakan Shift+Tab. 
 

Tindakan Menu Konteks 

Menu konteks juga tersedia untuk objek yang terbuka di panel navigator. Anda 

dapat mengklik kanan pada objek yang dipilih atau mengklik panah kecil yang 

muncul saat Anda mengarahkan kursor ke atasnya untuk membuka menu. 
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Isi menu ini bervariasi tergantung pada jenis objek yang dipilih (mockup, aset, 

simbol, atau sampah) tetapi umumnya berisi opsi seperti mengganti nama, 

pindah ke sampah, dan duplikat. Dalam tampilan Mockup, ini juga berisi 

tindakan untuk bekerja dengan alternatif. 

 

Mengganti Nama Mockup 

Mengganti nama mockup dapat dilakukan melalui menu konteks atau dengan 

mengklik dua kali pada nama mockup di panel navigator. Mockup dengan link 

akan diperbarui secara otomatis ketika nama mockup yang ditautkan berubah. 

 

 

 

 

 

Panel Properti 
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Panel di sisi kanan aplikasi (saat ditampilkan) menampilkan properti untuk 

Kontrol atau objek yang dipilih. Tergantung pada ikon mana yang dipilih, ikon ini 

akan menampilkan Inspektur  Properti atau Panel Info Proyek. Hal ini dapat 

disembunyikan dengan membatalkan pilihan kedua ikon panel di toolbar atau 

menghapus centang Inspektur dan Informasi Proyek di menu View. 
 

 

 

 

Tampilan kisi thumbnail 
Mengklik ikon di sebelah kanan  sakelar panel navigator akan beralih ke tampilan 

kisi thumbnail, yang ditunjukkan di sini. 

 
 

 

https://balsamiq.com/wireframes/desktop/docs/projectinfo
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Tampilan ini menunjukkan thumbnail dari semua mockup Anda dan berguna 

untuk mendapatkan gambaran umum proyek Anda. Ini memungkinkan Anda 

untuk melihat lebih banyak maket Anda sekaligus dan merupakan tampilan yang 

baik untuk digunakan untuk menyusun ulang dan merapikan (misalnya, 

mengganti nama dan pindah ke tempat sampah). Anda dapat membuang 

beberapa mockup sekaligus dengan memilihnya (menggunakan CTRL / Shift + 

klik) dan membuka menu konteks. 

 

 

 

Tampilan kisi thumbnail tersedia saat melihat mockup dan aset, dan merupakan 

satu-satunya tampilan yang tersedia untuk sampah. 

 

Sampah 
Balsamiq Mockups 3 memiliki sampah untuk maket, aset, dan Simbol yang telah 

Anda hapus. Ini memudahkan untuk menjaga proyek Anda tetap rapi saat Anda 

membuat kemajuan tetapi masih memungkinkan Anda untuk menelusuri atau 

memulihkan konsep sebelumnya. 
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Untuk memulihkan objek yang dibuang dari panel Tong Sampah, klik panah 

menu konteks dan pilih "Pulihkan." Anda juga memiliki opsi untuk menghapus 

secara permanen. 

 

 

 

 

 

Bekerja pada Layar Kecil 
Saat bekerja pada layar laptop kecil, Anda mungkin ingin memaksimalkan jumlah 

Canvas yang Anda lihat. 

 

Untuk alasan ini, panel UI Library, Navigator,  dan Properties semuanya dapat 

diaktifkan dan dinonaktifkan menggunakan mouse atau keyboard. 

 

Panel ini disorot di bawah ini bersama dengan ikon yang dapat digunakan untuk 

mengaktifkannya atau nonaktif. 
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Pintasan keyboard untuk mengaktifkannya tercantum di sini: 

 

 Perpustakaan UI: ⌘  + L 

 Navigator: ⌘  + J 

 Panel Properti: ⌘  + ;

Panel Info Proyek: ⌘ + , 
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← Introduction to Balsamiq Mockups 3 

Sharing in Balsamiq Mockups 3 for Desktop → 

 

Menyembunyikan semua panel menghasilkan antarmuka pengguna yang terlihat 

seperti ini: 

 
 

 

Ikon toolbar terkait berubah dari biru menjadi putih saat panel tidak ditampilkan. 

 

Perhatikan bahwa Anda masih dapat menambahkan kontrol ke kanvas saat 

Perpustakaan UI disembunyikan menggunakan Tambahkan Cepat . Dan Anda 

dapat menavigasi di antara maket Anda menggunakan ikon toolbar tambahan 

yang muncul ketika Panel Navigator disembunyikan. 

 

 

 

https://balsamiq.com/wireframes/desktop/docs/intro/
https://balsamiq.com/wireframes/desktop/docs/intro/
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← Balsamiq Mockups 3 Application Overview Working with UI Controls → 

 
 

Balsamiq untuk Dokumentasi Desktop 
 
 

 
 

Balsamiq  untuk Desktop Dokumen > Berbagi di Balsamiq Mockups 3 untuk Desktop 

 

Berbagi di Balsamiq Mockups 3 untuk 
Desktop 

 

 

 

Kolaborasi adalah dasar dari Mockup. Dari bekerja dengan klien dan pelanggan 

Anda, hingga berkolaborasi dengan desainer dan programmer Anda, Mockups 

dibangun dengan kolaborasi pada intinya. Berikut adalah cara Anda dapat 

membagikan proyek Anda. 

 

 

Bagikan File Proyek Mockup 
Cara terbaik untuk membagikan pekerjaan Anda adalah dengan mengirim file 

proyek Mockups Anda (file dengan ekstensi .bmpr) langsung ke klien dan 

kolaborator Anda. Pastikan untuk menyertakan tautan untuk mengunduh 

Balsamiq Mockups - jika mereka belum memilikinya. 

 

Beri tahu klien Anda untuk menginstal Balsamiq Mockups dan buka file yang 

Anda kirim. Mereka akan dapat pergi layar penuh dan mengklik sekitar atau 
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Note: PDFs with links also work great on mobile phones and tablets! 

melihat maket di editor. Selama masa uji coba 30 hari, mereka akan dapat 

membuat perubahan dan menyimpannya. 

 

 

Ketika uji coba berakhir, mereka tidak akan dapat mengedit tetapi mereka masih 

dapat melihatnya, mengklik tautan, dan bahkan menyalin string teks jika 

diperlukan. 

 

Berbagi Dokumen PDF Interaktif 
PDF yang dihasilkan oleh Mockup sepenuhnya interaktif. Itu berarti bahwa 

mereka tidak hanya menampilkan proyek Anda seperti yang telah Anda rancang, 

mereka juga akan menghormati tautan apa pun yang telah Anda tambahkan ke 

proyek juga. Ini adalah salah satu cara terbaik untuk berbagi proyek Anda 

dengan kolaborator dan klien yang tidak perlu melakukan perubahan. 

 

 

 

Bagikan gambar PNG 
Anda dapat mengekspor semua mockup Anda ke gambar PNG statis, dan 

mengirimkannya ke klien Anda. Info lebih lanjut tentang fitur itu di sini. 

 

 

Gunakan Balsamiq Cloud 
Balsamiq Cloud adalah solusi wireframing berbasis web kami yang dirancang 

untuk tim besar. Dengan Balsamiq Cloud, Anda dapat mengundang kolaborator 

Anda untuk melihat, berinteraksi, dan bahkan mengedit proyek Anda. Proyek 

Anda yang ada sepenuhnya kompatibel dengan Balsamiq Cloud, yang perlu Anda 

lakukan hanyalah mengunggahnya. Lihat hari ini dan lihat cara membagikan 

pekerjaan Anda dengan klien luar di Balsamiq Cloud.. 
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← Balsamiq Mockups 3 Application Overview Working with UI Controls → 

 

 

Kolaborasi Real-Time 
Kolaborasi real-time kini  tersedia di enam aplikasi kami: 

 

Awan Balsamiq 

Balsamiq Wireframes untuk Google Drive 

Wireframes Balsamiq untuk Confluence Cloud dan Confluence Server 

Balsamiq Wireframes untuk Jira Cloud dan Jira Server 
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← Sharing in Balsamiq Mockups 3 for Desktop The Property Inspector → 

Note: Full list of keyboard shortcuts here. 

 
 

Balsamiq untuk Dokumentasi Desktop 
 
 

 
 

Balsamiq untuk Dokumen Desktop > Bekerja dengan Kontrol UI 

 

Bekerja dengan Kontrol UI 
 

 

 

Menambahkan Kontrol UI 
 

 

 

 

Untuk menambahkan kontrol UI ke mockup Anda, klik ganda atau seret kontrol 

di Pustaka UI atau ketik kata kunci ke alat Tambahkan Cepat. 

 

Anda juga dapat menduplikasi kontrol yang sudah ada di kanvas menggunakan 

salin dan tempel atau perintah duplikat (CTRL/CMD + D). ALT / Option + drag 

juga akan menduplikasi kontrol dan memungkinkan Anda untuk 

menempatkannya menggunakan mouse Anda. 
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Memilih Kontrol UI 
Ada beberapa cara berbeda untuk memilih kontrol UI. Jika Anda terbiasa dengan 

perangkat lunak grafis, ini seharusnya tidak mengejutkan. 

 

Mengklik kontrol UI akan memilihnya 

Menyeret persegi panjang yang membungkus banyak kontrol UI memilihnya 

SHIFT + KLIK pada kontrol menambahkannya ke pilihan 

CTRL/CMD + KLIK pada kontrol yang dipilih menghapusnya dari pilihan 

Tahan ALT untuk mengabaikan item di belakang mouse dan drag-select 

Untuk memilih kontrol yang berada di belakang kontrol lain, klik kanan pada 

kontrol atas untuk membuka menu yang memungkinkan Anda memilih kontrol 

di belakangnya. 

 

 

 

 
 

 

Memindahkan Kontrol UI 
Setelah Anda memilih satu atau beberapa kontrol UI, ada beberapa cara berbeda 

untuk memindahkannya di kanvas. 

 

Anda dapat menyeretnya dengan mouse Anda (tahan tombol SHIFT untuk 

mempertahankan posisi horizontal atau vertikal asli) 

Note: To see this and the other techniques in this article demonstrated in a video, see 

this tutorial on Tips for Working with Controls. 
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Anda dapat "mendorongnya" satu piksel sekaligus dengan tombol 

ATAS/BAWAH/KIRI/KANAN keyboard Anda 

Anda dapat memindahkannya dengan langkah yang lebih besar (10 piksel) 

dengan menahan SHIFT dan menggunakan tombol 

ATAS/BAWAH/KIRI/KANAN keyboard Anda 

Anda dapat memindahkan kontrol agar disejajarkan dalam satu arah 

dengan menggunakan alat perataan yang ditunjukkan  di bawah ini 

 

 

Snapping dan Panduan Cerdas 
Saat Anda memindahkan objek di kanvas, Mockup mencoba menyarankan 

penyelarasan relatif terhadap objek lain di kanvas menggunakan panduan 

cerdas. Ini membuat penyelarasan sedikit lebih mudah dan membuat Mockup 

Anda umumnya terlihat lebih rapi. 

 

Jika Anda ingin menonaktifkan sementara fitur ini, Anda dapat menahan tombol 

CTRL / CMD saat memindahkan atau mengubah ukuran, dan snapping akan 

dimatikan. 

 

 

Mengubah Ukuran Kontrol UI 
Mengubah ukuran kontrol yang dipilih itu mudah. Anda cukup mengambil tepi 

atau sudut persegi panjang pilihan dan menyeretnya. 

 

Jika Anda ingin membatasi proporsi saat menyeret dari sudut, tahan tombol 

SHIFT sambil menyeret. 

 

Anda juga dapat menggunakan keyboard untuk mengubah ukuran kontrol yang 

dipilih. CTRL/CMD+ALT+tombol panah keubah ukuran dengan penambahan 

1px, CTRL/CMD+ALT+SHIFT+tombol panah untuk kenaikan 10px. 

 

Cara lain untuk mengubah ukuran beberapa kontrol ke "ukuran alami" mereka 

adalah dengan menggunakan fungsi Ukuran Otomatis yang ditemukan di 

Inspektur Properti. 
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Untuk mengubah ukuran satu atau beberapa kontrol agar sesuai dengan ukuran 

kontrol lainnya (agar memiliki lebar atau tinggi yang sama), Anda dapat 

menggunakan tombol "Ubah Ukuran Ke..." di menu Edit. 

 

 

 

 

Pilih beberapa kontrol dan gunakan opsi ini untuk mengukur semua kontrol yang 

dipilih agar sesuai dengan kontrol tersempit, terlebar, terpendek, atau tertinggi 

dalam pilihan. 

 

Menyelaraskan Kontrol UI 
Anda dapat menyelaraskan dan mendistribusikan kontrol (spasi habis) dengan 

memilih beberapa kontrol dan mengklik kanan untuk membuka menu yang 

ditunjukkan di bawah ini. 
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Opsi yang sama ditampilkan di pemeriksa properti saat beberapa kontrol dipilih. 
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Kontrol UI Berlapis 
Anda dapat melapisi kontrol seolah-olah itu adalah potongan kertas di kanvas 

mockup. Untuk melakukannya, Anda memilih kontrol yang ingin Anda lapisi dan 

pilih salah satu dari empat perintah pelapisan yang tersedia melalui menu klik 

kanan atau Inspektur Properti: Bawa ke Depan, Majukan, Kirim Mundur, dan 

Kirim ke Belakang. Pintasan keyboard juga tersedia. 

 
 

 

 

Mengunci Kontrol UI 
Mengunci kontrol akan mencegahnya dipilih. Ini dapat berguna untuk kontrol 

latar belakang yang ingin Anda tetap di tempatnya atau tidak ingin dipilih secara 

tidak sengaja (browser atau kontrol iPhone, misalnya). Anda dapat mengunci 

kontrol dengan memilihnya dan memilih "Kunci (nama kontrol)" dari menu 

konteks, atau dengan mengklik ikon kunci di bilah alat. 
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Untuk membuka kunci kontrol, klik kanan padanya saat kursor mouse Anda 

berada di atasnya. 

 

Menghapus Kontrol UI 
Untuk menghapus beberapa kontrol UI dari kanvas mockup, pilih dan tekan 

tombol DELETE kunci. Atau, Anda dapat mengklik ikon tempat sampah di bilah 

alat atau memilih "Hapus" dari menu Edit. 

 

 

Memutar Kontrol UI 
Beberapa  kontrol UI kami dapat diputar melalui Inspektur Properti (kontrol label, 

gambar, dan ikon , misalnya), tetapi sebagian besar tidak bisa. Jika Anda terbiasa 

dengan alat menggambar generik, ini mungkin mengejutkan. Keterbatasan ini 

disengaja, dan bukan karena kompleksitas pemrograman (tidak sulit untuk 

menambahkan secara teknis). 

 

Alasan kami tidak mendukung rotasi semua kontrol karena kami percaya bahwa 

dalam 90% kasus, itu tidak diperlukan dalam wireframe. Bahkan, menambahkan 

kemampuan untuk memutar kontrol apa pun kemungkinan akan menghasilkan 

wireframe yang sangat sulit jika bukan tidak mungkin diterapkan oleh tim 

pengembangan. 

 

Jika Anda merasa perlu memutar kontrol lain, beri tahu kami di utas forum ini 

dan kami akan membahas apakah akan menambahkannya bersama. Solusinya 

adalah memutar kontrol dalam aplikasi menggambar dan kemudian 

mengimpornya sebagai gambar. 

 

 

Mengubah Kontrol UI 
Banyak kontrol dapat dikonversi menjadi kontrol lain. Ini dapat berguna ketika 

Anda sudah memiliki konten di mockup Anda tetapi ingin menggunakan jenis 
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kontrol yang berbeda tanpa mengetik ulang konten (mengubah input teks 

menjadi kotak kombo, misalnya). 

 

Cukup klik pada kontrol dan buka menu konteks di sebelah nama kontrol di 

Inspektur Properti untuk melihat jenis kontrol mana yang dapat diubah menjadi 

kontrol yang dipilih. Pilih kontrol yang ingin Anda ubah atau gunakan pencarian 

untuk mencarinya. 

 
 

Anda dapat mengubah kontrol dengan cepat menggunakan pintasan CTRL+T 

untuk memunculkan menu transformasi di tengah kanvas. 

 



Halaman | 42 

 

Pengelompokan Kontrol UI 
Terkadang Anda mungkin ingin mengelompokkan beberapa kontrol untuk 

menyelaraskannya dengan lebih baik atau memindahkan semuanya sekaligus. 

Untuk mengelompokkan serangkaian kontrol, pilih kontrol dan tekan CTRL+G 

pada keyboard Anda atau gunakan perintah Grup di menu Edit atau bilah alat. 

Kontrol akan berubah warna menjadi ungu untuk menunjukkan bahwa mereka 

dikelompokkan. Setelah dikelompokkan, kontrol akan berperilaku sebagai satu 

saat bergerak atau menyelaraskan. Untuk memisahkan kontrol, tekan 

CTRL+SHIFT+G pada keyboard Anda atau gunakan perintah Pisahkan grup di 

menu atau bar alat. 

 
 

 

Anda dapat mengklik dua kali pada grup untuk "memasukkannya" dan mengedit 

isinya. Bilah breadcrumb mengambang kecil akan menunjukkan bahwa Anda 

sedang mengedit grup dan memungkinkan Anda untuk menavigasi kembali 

keluar dari grup (Anda juga dapat menggunakan tombol Escape). Grup dapat 

ditumpuk, seperti yang ditunjukkan di bawah ini. 
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Note: To crop a single control, select it and group it (yes, a group with only one 

element). You will then be able to crop it. 

 

Anda dapat memberi nama grup melalui Inspektur Properti. Ini dapat membantu 

ketika Anda memiliki banyak grup dan perlu "tahu di mana Anda berada" ketika 

Anda mengedit konten mereka. Penamaan grup juga berguna saat membuat 

Simbol. 

 

 

Grup Pemotongan 
Dimungkinkan untuk memotong (menutupi) sekelompok kontrol untuk hanya 

menampilkan bagian yang dipilih. Saat grup dipilih, ikon potong akan 

ditampilkan di Inspektur Properti. Klik untuk mengedit area grup yang terlihat. 

 

 

 

Kontrol Dasar "Menggambar" 
Ada tiga kontrol yang dapat Anda tambahkan ke kanvas dengan "menggambar" 

mereka dengan mouse Anda sambil menahan tombol huruf. Untuk menggambar 

persegi panjang dengan cepat di kanvas, tahan tombol R dan seret mouse Anda. 
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← Sharing in Balsamiq Mockups 3 for Desktop The Property Inspector → 

Menahan T sebagai gantinya akan menggambar blok teks, dan Y kan 

menghasilkan satu baris teks. 

Setelah menambahkan kontrol ini, Anda dapat dengan mudah mengonversinya 

ke kontrol lain dengan menggunakan menu transformasi yang dijelaskan di atas. 

 

 

 



Halaman | 45 

 

← Working with UI Controls Working with Alternates → 

 
 

Balsamiq untuk Dokumentasi Desktop 
 
 

 
 

Balsamiq untuk Dokumen Desktop > Inspektur Properti 

 

Inspektur Properti 
 

 

 

The Property Inspector adalah panel di sisi kanan aplikasi yang memungkinkan 

Anda untuk mengatur beberapa properti umum seperti perataan, posisi dan 

ukuran serta pengaturan khusus untuk kontrol tertentu (status pemilihan, 

properti teks, warna, dll.). Ini tersedia saat melihat maket, aset, dan Simbol.  
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Anda dapat menampilkan dan menyembunyikan Inspektur Properti dengan 

mengklik ikon sakelar di atasnya (pintasan keyboard CTRL / CMD +; atau ALT / 

Option + Enter). Saat disembunyikan, Anda juga dapat menampilkannya dengan 

mengklik kanan kontrol dan memilih "Properties...". 

 

Jika Anda memiliki beberapa kontrol yang dipilih, itu akan menampilkan properti 

yang umum untuk semua kontrol yang dipilih serta opsi untuk menyelaraskan 

dan mendistribusikan. 

 

 

Mengubah Jenis Kontrol 
Banyak kontrol di Balsamiq Mockups dapat diubah menjadi kontrol lain melalui 

menu konteks di sebelah nama kontrol di Inspektur Properti. 

 

 
 

 

Ini dapat berguna ketika Anda sudah memiliki konten di mockup Anda tetapi 

ingin menggunakan jenis kontrol yang berbeda tanpa mengetik ulang konten 

(mengubah input teks menjadi kotak kombo, misalnya). Cukup klik pada kontrol 

dan buka menu untuk melihat jenis kontrol mana yang dapat diubah menjadi 
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Note: You can format notes text using the syntax described here to make text bold, 

underlined, etc. 

← Working with UI Controls Working with Alternates → 

kontrol yang dipilih. 

 

 

Menambahkan Catatan ke Mockup, Simbol, dan Aset 
Anda 
Ketika tidak ada kontrol yang dipilih, Inspektur Properti menampilkan catatan 

untuk mockup, aset, atau Simbol yang dipilih. Dalam tampilan Mockup, panel 

juga menampilkan mockup alternatif. 

 

 

 
 

Untuk aset dan Simbol itu juga menunjukkan hitungan dan nama maket di mana 

objek yang dipilih digunakan. 
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← The Property Inspector Working with Text → 

 
 

Balsamiq untuk Dokumentasi Desktop 
 

 
 

Balsamiq untuk Dokumen Desktop > Bekerja dengan Alternatif 

 

Bekerja dengan Alternatif 
 

 

 

Alternatif (juga kadang-kadang disebut sebagai versi atau cabang) 

memungkinkan Anda untuk membuat 

variasi pada satu desain  mockup tanpa menambahkan lebih banyak mockup 

ke proyek Anda. 

 

Membuat alternatif dapat berguna selama fase desain awal ketika 

mengeksplorasi konsep dan pada tahap selanjutnya bagi pengulas untuk 

menambahkan umpan balik mereka dan mengusulkan perubahan. 

 

Beberapa kemungkinan alasan untuk menggunakan alternatif: 

 

Anda hanya ingin membuat satu mockup per layar tetapi memiliki beberapa 

ide tentang masing-masing. Anda ingin saran untuk perbaikan desain 

tetapi tidak ingin orang lain mengubah maket Anda. 

Anda ingin mengirim proyek Anda untuk umpan balik dan melacak umpan 

balik setiap orang secara individual. 
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Anda ingin mencoba ide-ide desain baru tanpa memasukkannya ke dalam 

mockup untuk rilis saat ini. 

 

Membuat Alternatif 
Saat melihat mockup tanpa kontrol apa pun yang dipilih, Anda akan melihat 

bagian panel  Inspektur Properti  yang disebut  "Versi Alternatif" di bawah catatan 

untuk mockup itu. 

 

 
 

 

Untuk membuat alternatif baru, klik ikon "+" (plus) di sebelah "Versi 

Alternatif" 

 

 

atau gunakan menu konteks di panel Navigator. 
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Note: You can create an alternate of an alternate. Clicking the "+" (plus) icon when an 

alternate is selected creates an alternate of the selected version rather than the official 

version. 

 
 

 

Ini akan membuat salinan mockup saat ini sebagai versi alternatif untuk Anda 

modifikasi. Secara default secara otomatis akan diberi nama dengan kata 

"Alternatif" diikuti oleh beberapa angka dan huruf acak untuk memastikan bahwa 

nama itu unik. 

 

 

 

 

Pilihan dalam daftar versi alternatif memberi tahu Anda versi mockup mana 

yang sedang Anda kerjakan. Anda dapat membuat alternatif sebanyak yang 

Anda inginkan. 
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Ketika alternatif ada, ikon akan muncul di sebelah nama di panel Navigator  yang 

menunjukkan bahwa ada alternatif. Saat Anda mengerjakan versi alternatif, panel 

Navigator akan menampilkan nama alternatif dalam tanda kurung. 

 
 

 

Untuk mengganti  nama alternatif, klik dua kali pada nama dalam daftar versi 

alternatif atau gunakan konteks atau menu klik kanan dan pilih "Ubah nama ..." 

 

 

 

 

 

Mengedit Alternatif 
Setelah Anda membuat versi alternatif, Anda dapat mengeditnya seperti mockup 

lainnya, termasuk menambahkan aset dan simbol. Perubahan yang Anda buat 

tidak akan memengaruhi mockup asli (ditampilkan sebagai Versi Resmi). Anda juga 

dapat menambahkan catatan di panel catatan sebagai alternatif untuk 

menggambarkan pemikiran Anda tentang hal itu atau berkomunikasi dengan 

orang lain tentang hal itu. 
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Untuk beralih di antara versi alternatif mockup, pilih nama versi dari daftar di 

panel properti atau dari menu konteks di panel Navigator. Anda juga dapat 

beralih kembali ke Versi Resmi dengan memilihnya dalam daftar. 
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Note: You can undo this action by using the undo command (CTRL/CMD+Z) three 

times. 

 
 

 

Mempromosikan Alternatif 
Jika Anda memutuskan bahwa Anda menyukai satu alternatif lebih baik daripada 

mockup asli, Anda dapat "mempromosikannya" ke versi resmi, yang 

menggantikan dan menimpa yang asli. 

 

 

 

 

 

Alternatif yang dipromosikan dipertahankan jika Anda ingin mempertahankannya 

sebagai bagian dari riwayat perubahan. Jika tidak, Anda dapat membuangnya . 

 

Alternatif Duplikasi 
Anda dapat menduplikasi mockup dari menu kontekstual. Melakukan hal ini akan 

membuat alternatif baru yang diberi nama secara acak yang merupakan salinan 

persis dari alternatif yang Anda pilih untuk diduplikasi. 

Note: If you link to a mockup that contains an alternate the link will go to the version of 

the mockup that is selected in the alternates list. The same rule applies to exporting. 

The selected versions of your mockups will be exported. 
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Kadang-kadang, bagaimanapun, alternatif tumbuh menjadi mockup sendiri. Jika 

Anda ingin membuat mockup baru berdasarkan alternatif, Anda dapat memilih 

opsi "Duplicate As New Mockup" dari menu kontekstual. 

 

 

 

 

Mockup baru akan diberi nama menggunakan  Nama Alternatif dan kemudian 

Nama Mockup Asli. Jadi jika Anda memiliki alternatif bernama "Rotated Header", di 

mockup "Homepage" Anda, mockup yang dibuat dari alternatif akan diberi nama 

"Rotated Header Homepage". 
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Penggabungan Alternatif 
Jika Anda ingin menggabungkan bagian-bagian alternatif dengan versi resmi, 

Anda dapat menggunakan opsi penggabungan. 

 

 

 

 

Memilih "Gabung dengan Resmi" akan menambahkan konten versi yang dipilih 

ke versi resmi, di sebelah kanan konten mockup, seperti yang ditunjukkan di 

bawah ini. 
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Jika catatan dalam alternatif berbeda dari catatan dalam aslinya, mereka juga 

akan digabungkan, dipisahkan oleh garis horizontal putus-putus. 

 

 

 

 

Anda kemudian dapat mengedit konten secara manual untuk membuat versi 

resmi baru yang merupakan kombinasi dari elemen pilihan setiap versi. 
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Note: Alternates cannot be recovered after they have been discarded. 

Membuang Alternatif 
Setelah selesai meninjau atau mengintegrasikan versi alternatif ke dalam versi 

resmi, Anda dapat menghapus alternatif yang tidak lagi Anda inginkan 

menggunakan opsi "Buang". 

 

 

Alternatif dalam Mode Presentasi Layar Penuh 
Anda dapat melihat alternatif Anda dalam Mode Presentasi Layar Penuh dengan 

menggunakan dropdown navigator. 

 

 
 

 

Saat Anda memilih mockup alternatif dalam tampilan ini, namanya akan muncul 

dalam tanda kurung di sebelah nama mockup resmi. 

 

Alternatif Proyek 
Dalam beberapa kasus, Anda mungkin ingin mengusulkan satu set desain 

alternatif di beberapa maket. Ini mungkin terjadi jika Anda meninjau maket orang 

lain dan ingin mereka melihat perubahan desain yang Anda usulkan di seluruh 

proyek. 
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Note: This is conceptually similar to creating a branch in a codebase, except that it only 

applies to mockups that have specific alternate version names. 

 

Saat mengganti nama alternatif, Anda dapat memilih dari daftar nama alternatif 

yang ada di dialog ganti nama. Ini membuatnya mudah untuk menggunakan 

nama alternatif yang sama di beberapa maket. 

 

 

 

 

Di panel Navigator di sebelah kata Mockup, menu menampilkan nama semua 

alternatif yang muncul di proyek Anda. 

 

Memilih alternatif dari daftar ini akan memilih  alternatif itu di semua mockup 

yang memiliki alternatif dengan nama itu. 

 

 

 

 

 

Jadi, misalnya, jika Anda membuat serangkaian alternatif yang disebut "Leon's 

Proposal" dan menggunakan menu konteks yang ditunjukkan di atas untuk 

memilih nama itu, mockup apa pun dengan alternatif yang disebut "Leon's 

Proposal" akan beralih tampilan ke versi alternatif itu. 
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← The Property Inspector Working with Text → 

Maket tanpa alternatif dengan nama itu tidak akan diperbarui. Tindakan 

mempromosikan, menggabungkan, dan membuang tidak tersedia di beberapa 

mockup sekaligus. 
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← Working with Alternates Working with Data Grids / Tables → 

 
 

Balsamiq untuk Dokumentasi Desktop 
 

 
 

Balsamiq untuk Dokumen Desktop > Bekerja dengan Teks 

 

Bekerja dengan Teks 
 

 

 

Banyak kontrol UI Mockup, seperti Button, Label, atau DataGrid, memiliki teks di 

dalamnya. Untuk mengedit teks, klik dua kali pada kontrol dan mulailah 

mengetik. Atau, jika Anda memilih kontrol, cukup tekan Enter atau F2 untuk 

mulai mengedit. Untuk menerapkan teks yang Anda ketik, cukup klik di mana 

saja selain bidang teks yang Anda ketik atau tekan Enter atau CTRL+Enter. Jika 

Anda ingin membuang perubahan teks yang baru saja Anda buat, tekan tombol 

ESC. 

 

Beberapa kontrol menggunakan karakter tertentu sebagai pemisah. Misalnya, 

untuk membuat beberapa tab di bilah tab, Anda memisahkannya dengan koma. 
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Atau, karakter spasi memisahkan tag dalam kontrol Tag Cloud. Beberapa kontrol 

lain, seperti Pohon, menggunakan karakter lain sama sekali. Dalam kasus seperti 

itu, teks default untuk Kontrol mencakup penjelasan tentang cara 

menggunakannya. 

 

Saat mengedit teks dalam kontrol Label atau Paragraf, Anda akan melihat 

sejumlah kecil di sudut kanan bawah kotak pengeditan. Ini adalah jumlah 

karakter, yang dapat berguna untuk copywriting atau tujuan lain. 

 

 

Pemformatan Dasar 

Gaya Teks 

Anda dapat menggunakan notasi berikut untuk memformat hanya bagian 

tertentu dari teks kontrol Anda. 

 

Untuk cetak miring, gunakan _this notation_ untuk tautan, gunakan [notasi 

ini] untuk huruf tebal, gunakan *notasi ini* 

untuk dinonaktifkan, gunakan -notasi ini- untuk digarisbawahi, gunakan 

&notasi ini& 

Untuk dicoret, gunakan ~notasi ini~ 

Untuk warna, gunakan {color:#FF0000}notasi ini{color}. Untuk ukuran font, 

gunakan {size:16}this notation{size} 

 

Semua sintaks di atas bekerja di sekitar kata-kata yang dipisahkan oleh spasi 

putih, dan garis bawah akan bekerja dalam kata-kata. 
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**Notes:** 

1. The #FF0000 above is the color in HEX form, just like HTML. The macro will work with 

or without the pound sign. You can also use certain color names (green, yellow, etc.) 

which you can find by moving your mouse over the colors in the color palette in the 

Property Inspector. 

2. See the [next section](#making-links-in-text-actually-work) for how to turn [linked 

text] into functioning links to websites or other mockups. 

3. This formatting syntax also works for text entered into the [Notes panel] 

(/wireframes/desktop/docs/inspector/#adding-notes-to-your-mockups-symbols- 

and-assets) _except_ italic and strikethrough. 

 

Berikut adalah tangkapan layar dari tampilan teks di atas dalam kontrol Paragraf, 

misalnya: 

 

 

 

 

Pintasan akan berfungsi hampir di mana-mana yang masuk akal, dan Anda dapat 

menggabungkannya, jadi untuk membuat tautan miring gunakan [_this_] atau 

_[this]_. 

 

Beberapa kontrol seperti Paragraf atau Label memungkinkan Anda untuk 

"menghapus tebal" teks melalui panel Inspektur Properti. Jika Anda 

melakukannya, kata-kata yang Anda *tebalkan* akan tetap tebal. Beberapa 

kontrol menggunakan teks tebal secara default, jadi menebalkan teks dalam 

kontrol tersebut tidak akan membuat perbedaan. 

 

Jika Anda ingin menampilkan karakter pemformatan khusus ini sebagai teks 
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yang sebenarnya, Anda dapat menghindari *, 

_, -, [ dan ] karakter dengan \*, \_, \-, \[ dan \], jadi jika Anda ingin menulis "ini 

[adalah] beberapa teks" dan tidak ingin "adalah" menjadi tautan, cukup ketik "ini 

\[adalah\] beberapa teks". 

 

Pemisah Baris 

Sebagian besar kontrol memungkinkan Anda menyisipkan hentian baris untuk 

membungkus teks dari satu baris ke baris berikutnya. Anda dapat melakukan ini 

dengan menulis \r di depan teks yang ingin Anda mulai pada baris baru. Lihat 

contoh di bawah ini di mana jeda baris digunakan dalam item kedua dalam 

kontrol Tombol Radio. 

 

 

 

Daftar Berpoin 

Dalam kontrol paragraf, Anda bisa membuat daftar berpoin dengan teks 

sebelumnya dengan tanda hubung atau tanda bintang diikuti dengan spasi. 

 

 
 

 

Membuat Tautan dalam Teks Benar-Benar Berfungsi 
Jika Anda menggunakan notasi tautan di atas (misalnya, [ini adalah tautan]), 

Anda dapat mengubah teks berformat tautan menjadi tautan aktual 

menggunakan sintaks penurunan harga. 

* item  1 

* item  2 

- item  3 

- item  4 
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[Google Home Page](google.com) 

[Google Home Page](www.google.com) 

[Google Home Page](http://www.google.com) 

[Google Home Page](https://google.com) 

 
[Features Page](features) 

 

Untuk melakukannya, tambahkan tujuan link dalam tanda kurung segera setelah 

teks link. Tujuan tautan dapat berupa URL atau nama mockup lain di folder yang 

sama. Semua format berikut valid. 

 

Alamat web: 

 

 

Maket dalam proyek yang sama: 

 

 

Menambahkan tautan dengan cara ini akan menyebabkannya muncul di 

Inspektur Properti juga, seperti yang ditunjukkan di bawah ini. 

 

Teks ini 

 
 

 

Hasil dalam 
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Note: If the whole control is linked, text links will be disabled. If the whole control is 

subsequently unlinked, the previous text links will return. 

 

 

Anda dapat menautkan string teks tertentu serta seluruh kontrol. 

 

Makro Lainnya 

Lorem 

Ketik lorem di Paragraf atau Area Teks untuk menggunakan  generator Lorem 

Ipsum  kami. 

 

 

 
 

{Nama Mockup} 

Ketik {mockup-name} (semua huruf kecil) dalam kontrol Label, Teks, Judul, atau 

Subjudul untuk memperlihatkan nama mockup saat ini. 
 

 

Teks Tempat Penampung 
Pilihan lain untuk membuat teks placeholder, selain generator teks Lorem Ipsum, 

adalah dengan menggunakan kontrol Line of Text dan Block of Text.  
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Note: Read about drawing these controls directly on the canvas to learn how to add 

them really quickly. 

← Working with Alternates Working with Data Grids / Tables → 

 

 

 

Anda dapat mengonversinya menjadi teks nyata kapan saja dengan mengeditnya 

dan memasukkan beberapa teks. 
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← Working with Text Working with Icons → 

 
First Name, Last Name, Email Address 

firstname, lastname, email@email.com 

 
 

Balsamiq untuk Dokumentasi Desktop 
 
 

 
 

Balsamiq untuk Dokumen Desktop > Bekerja dengan Kisi/Tabel Data 

 

Bekerja dengan Kisi / Tabel Data 
 

 

 

Kontrol Data Grid berfungsi seperti banyak kontrol berbasis teks lainnya. Ini 

menggunakan koma sebagai pemisah kolom dan baris baru sebagai baris. Tabel 

dasar dengan tiga kolom dan dua baris akan terlihat seperti ini: 

 

 

Anda dapat memilih apakah akan menampilkan baris pertama sebagai baris 

header di Inspektur Properti, serta menentukan tinggi baris, warna baris, dan 

garis kisi. 

 

Teks dalam Kisi Data dapat diformat sebagai tebal, miring, dll. menggunakan 

sintaks yang sama seperti kontrol teks lainnya. 

 

mailto:email@email.com
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Opsi Lebar Kolom 
Mockup memungkinkan Anda menentukan opsi lebar dan perataan individual 

untuk setiap kolom Kisi Data. 

Berikut adalah detail untuk membuat lebar kolom: 

 

Anda harus menambahkan baris teks khusus sebagai baris terakhir teks di 

tabel Anda, dan itu harus dibungkus oleh { } kurung kurawal 

Untuk setiap kolom, gunakan 0 jika Anda ingin kolom menjadi sekecil 

mungkin agar pas dengan teks dalam kolom itu, atau angka 

Angka menentukan ukuran relatif kolom, jadi {2,1} berarti "buat kolom 

pertama dua kali lebih besar dari kolom kedua dalam dua kolom ini 

Grid. Atau {70,20,10} berarti "dalam kisi 3 kolom ini, buat kolom ke-1 70%, 

ke-2 20% dan ke-3 10% dari lebar seluruh tabel. 

Anda dapat menggabungkan angka dan nol, misalnya, {1,0,4} 

Jika Anda ingin meratakan kolom satu per satu, tambahkan L, C atau R 

tepat setelah angka, seperti: {0R,2L,1}, yang berarti "dalam kisi 3 kolom ini, 

buat kolom ke-1 sekecil mungkin dan selalu ratakan ke kanan, yang kedua 

dua kali lebih besar dari yang ketiga dan selalu ratakan ke kiri,  dan 

gunakan perataan Kisi Data (dari inspektur properti) untuk memutuskan 

cara menyelaraskan kolom ke-3". 

 

 

Menggunakan Ikon dan Kontrol Pilihan dalam Kisi Data 
Data Grid mendukung ikon pengurutan di header menggunakan teks berikut: 

 

Naik: ^ Turun: v 

 

Kisi Data mendukung kotak centang tunggal atau tombol radio dalam sel tabel 

menggunakan teks berikut: 

 

Kotak centang: [] atau [ ] 

Kotak centang yang dipilih: [x] atau [v] atau [o] atau [*] atau [X] atau [V] atau 

[O] Kotak centang tak tentu: [-] 

Tombol radio: () atau ( ) 
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Name\r(job title) 

Note: If you have commas in your cells, you will have to escape them with a backslash 

like this: 

1\,000\,000 

← Working with Text Working with Icons → 

Tombol radio yang dipilih: (x) atau (v) atau (o) atau (*) atau (X) atau (V) atau 

(O) Tombol radio tak tentu: (-) 

 

 

Membuat Pengembalian Baris dalam Kisi Data 
Terkadang Anda ingin membuat pengembalian baris dalam sel tabel. Untuk 

melakukan ini, Anda dapat menggunakan "\r" untuk membuat pengembalian 

baris. 

 

Contoh kode di bawah ini akan dicetak pada dua baris. 

 

 

 

Menempelkan Data dari Excel 

Beberapa orang suka menyiapkan tabel dalam aplikasi spreadsheet seperti Excel. 

Anda bisa menyalin dan menempelkan rentang sel langsung dari Excel ke 

komponen Kisi/Tabel Data. Cukup salin / tempel dan itu hanya akan berfungsi. 

Ini juga bekerja dalam arah yang berlawanan dari Mockup ke Excel. 

 

 

 

Komponen mengenali koma dan tab sebagai pembatas. Apa pun yang lain harus 

diisi ke dalam sel. 
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← Working with Data Grids / Tables Working with Images and Assets → 

 
 

Balsamiq untuk Dokumentasi Desktop 
 

 
 

Balsamiq untuk Dokumen Desktop > Bekerja dengan Ikon 

 

Bekerja dengan Ikon 
 

 

 

Balsamiq Mockups 3 menyertakan  set ikon Font Awesome  yang menakjubkan. 

Ini berisi lebih dari 500 ikon dalam berbagai kategori yang dapat berukuran dari 

sangat kecil hingga sangat besar. Ini juga sering diperbarui dan kami berencana 

untuk mengikuti pembaruan setiap kali kami merilis versi baru produk kami 

(lebih lanjut tentang mengapa kami beralih di sini). 

 

Ini harus memenuhi semua kebutuhan ikon Anda, tetapi jika tidak, Anda dapat 

menambahkan ikon Anda sendiri atau meminta yang baru dari Font Awesome. 
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Ikon dari versi Balsamiq Mockups sebelumnya telah dipetakan ulang ke ikon 

baru. 

 

Menambahkan Ikon melalui Perpustakaan UI dan 
Tambah Cepat 
Juga baru di Balsamiq 3, ikon sekarang memiliki kategori sendiri di Perpustakaan 

UI sehingga Anda dapat menarik dan melepaskannya seperti kontrol lainnya. 
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Tidak hanya itu, mereka muncul di hasil Quick Add, menghemat waktu Anda saat 

mencari berdasarkan nama atau kata kunci. 

 

 

 

 

Hasil penelusuran ikon ditampilkan di bawah kontrol UI apa pun yang cocok 

dengan teks yang Anda masukkan. 

 

 

Menambahkan dan menukar ikon melalui inspektur 
properti 
Beberapa kontrol memungkinkan Anda untuk menambahkan ikon ke dalamnya 

(tombol, misalnya). Anda dapat melakukan ini  dari Inspektur Properti dengan 

salah satu dari dua cara: pencarian ikon dan dialog perpustakaan ikon. 

 

Pencarian Ikon 

Jika kontrol yang Anda pilih mendukung ikon, Anda akan melihat kotak 

pencarian ikon di inspektur properti. Ini bekerja seperti alat Quick Add, cukup 

ketik beberapa huruf dari nama ikon yang Anda cari dan daftar saran akan 

muncul sebagai kisi ikon untuk dipilih. Cukup klik salah satu yang ingin Anda 

pilih. 
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Anda kemudian dapat mengukur ikon dari "XS" (16px) ke "XXL" (128px). Anda 

juga dapat memutar ikon dengan kenaikan 90 derajat menggunakan tombol di 

sebelah kotak pencarian. 

 

Dialog Perpustakaan Ikon 

Jika Anda ingin menjelajahi semua ikon yang tersedia, klik ikon di sebelah kanan 

kotak pencarian ikon. 

 

 

 

 

Ini akan memunculkan dialog perpustakaan ikon, di mana Anda dapat 

menelusuri ikon berdasarkan kategori dan mempratinjaunya dengan ukuran 

berbeda. Anda dapat mengklik dua kali ikon untuk segera memilihnya atau klik 

sekali untuk memilih dan kemudian klik tombol "Pilih" untuk menambahkannya. 
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Setelah memilih ikon, Anda dapat mengubah ukurannya, memutarnya, atau 

menghapusnya melalui Inspektur Properti. 

 

 

Menambahkan Ikon Anda Sendiri 
Anda juga dapat dengan mudah menambahkan ikon Anda sendiri untuk 

digunakan dalam wireframe Anda. 

 

Menggunakan Aset Gambar Anda 
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Anda dapat memilih salah satu aset gambar yang diimpor  dan menggunakannya 

sebagai ikon. Mereka akan secara otomatis muncul di perpustakaan ikon, di 

bawah kategori Aset di bagian bawah. 

 

Menambahkan melalui Dialog Perpustakaan Ikon 

Anda juga dapat menambahkan ikon Anda sendiri dari dialog perpustakaan ikon. 

 
 

 

Pilih kategori Aset, lalu klik tombol plus kecil, pilih file gambar dan gambar Anda 

akan diubah ukurannya agar sesuai dengan ukuran ikon yang ada dan disalin ke 

aset Anda. 

 

 

Praktik Terbaik untuk Membuat atau Menyiapkan Ikon 
Kustom 
Mockup bekerja dengan warna dan transparansi, tetapi ikon yang Anda 

tambahkan mungkin tidak terlihat seperti yang Anda inginkan jika mereka tidak 

siap untuk bekerja seperti yang diharapkan Mockup. Berikut adalah beberapa 

tips untuk mendapatkan hasil maksimal dari ikon kustom Anda. 

 

Warna 

Maket menggunakan warna hitam sebagai warna untuk penggantian pada 

opasitas 100%. 

Ikon yang tidak dibuat dengan warna hitam dapat memiliki efek yang tidak 

diinginkan saat diwarnai. Sebaiknya gunakan hitam sebagai warna untuk 

ikon Anda. 
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← Working with Data Grids / Tables Working with Images and Assets → 

 

Area Transparan 

Maket mewarnai seluruh area buram ikon. 

Untuk hasil terbaik, sebaiknya hilangkan area "putih" ikon Anda 

menggunakan transparansi. PNG transparan berfungsi paling baik. 

 

Contoh di bawah ini menunjukkan ikon reguler di kolom kiri, ikon kustom yang 

disiapkan dengan benar dengan isian hitam di kolom tengah, dan ikon kustom 

yang tidak berfungsi dengan baik di kolom kanan. Untuk memperbaiki ikon di 

kolom kanan, tanda seru harus dibuat transparan, dan warna ikon harus hitam. 
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← Working with Icons Working with Markup → 

 
 

Balsamiq untuk Dokumentasi Desktop 
 

 
 

Balsamiq untuk Dokumen Desktop > Bekerja dengan Gambar dan Aset 

 

Bekerja dengan Gambar dan Aset 
 

 

 

Ada beberapa cara untuk menambahkan gambar ke mockup Anda. Cara 

termudah adalah dengan hanya drag dan drop file gambar dari komputer Anda 

ke kanvas Mockups. Baca terus untuk mempelajari lebih lanjut tentang 

menambahkan dan menggunakan gambar dan aset lainnya dalam proyek Anda. 

 

Menambahkan Gambar dalam Tampilan Mockup 
Seperti disebutkan di atas, menyeret gambar dari komputer Anda ke Balsamiq 

Mockups akan menambahkannya ke kanvas. Melakukan hal ini akan 

menempatkan gambar ke dalam mockup yang dipilih dan menyalin file gambar 

ke Aset  Anda sehingga Anda dapat dengan mudah menggunakannya kembali di 

mockup lainnya. 

 

Anda dapat memodifikasi properti gambar di Property Inspector, mirip dengan 

kontrol UI lainnya. 
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Properti khusus untuk gambar adalah sebagai berikut: 

 

Kotak drop-down menampilkan nama gambar saat ini. Membukanya 

memungkinkan Anda memilih gambar yang berbeda dari gambar yang telah 

diimpor ke Aset Anda. 

Ikon  "+" di sebelah kotak drop-down memungkinkan Anda menambahkan 

gambar dari komputer Anda. Ini sama dengan menyeret dan menjatuhkan 

file gambar. 

Mengklik ikon unduh membuka dialog untuk menambahkan gambar dari 

web dengan memasukkan URL secara langsung atau dengan mencari Flickr. 

Mockup mendukung format file gambar GIF, JPG / JPEG, dan PNG. File yang 

diunduh dari web akan disalin ke proyek Anda. 

Klik ikon putar di bawah drop-down gambar untuk memutar gambar Anda 

dengan kenaikan 90 derajat. 

Mengklik kotak dengan 'x' di dalamnya akan mengembalikan gambar ke 

gambar placeholder default. 

 Kotak centang "Buat sketsa!" akan mengonversi gambar Anda menjadi versi 

gambar garis hitam dan putih. 

 

Jika Anda belum menyiapkan gambar atau ingin menggunakan gambar 

placeholder untuk menjaga mockup Anda tetap rendah, Anda dapat 
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Note: You can delete an image by right-clicking on it in the UI Library and selecting 

"Move Image to Trash" or from the context menu in the Assets view. 

menambahkan kontrol Gambar dari Perpustakaan UI dan itu akan muncul 

sebagai kotak dengan 'X' melaluinya. Anda nantinya dapat menggantinya dengan 

gambar menggunakan properti gambar yang dijelaskan di atas. 

 

 
 

 

Setelah gambar ditambahkan ke proyek Anda, itu akan muncul di Perpustakaan 

UI sehingga Anda dapat dengan mudah menambahkannya ke mockup apa pun di 

proyek Anda. Kategori "Aset" akan menampilkan semua gambar yang telah Anda 

tambahkan ke proyek Anda. 

 

 

 

 

Ini juga berarti bahwa Anda dapat menambahkan gambar Anda ke mockup Anda 

dari  kotak Quick Add. Cukup ketik beberapa huruf pertama dari nama gambar 

dan itu akan muncul dalam daftar. 

 

 

Panel properti gambar juga memungkinkan Anda untuk memotong atau 

menutupi gambar untuk hanya menampilkan bagian yang dipilih dari mereka. 

Anda dapat menonton tutorial tentang memotong gambar di sini. Gambar yang 

telah dipotong akan menampilkan ikon untuk menghapus pemotongan di panel 
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properti. 

 

Selain kontrol Gambar, Anda juga dapat menyematkan gambar di kontrol Cover 

Flow. 

 

 

Menambahkan Gambar dalam Tampilan Aset 
Balsamiq Mockups 3 memiliki area khusus antarmuka pengguna untuk 

mengelola gambar, ikon, dan aset lainnya yang disebut tampilan Aset. 

 

 
 

 

Tampilan Aset menampilkan semua gambar dan ikon kustom yang telah 

ditambahkan ke project Anda. Anda dapat melakukannya dengan mengalihkan 

tampilan navigator ke Aset. 
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Anda dapat menambahkan gambar dalam tampilan Aset dengan menyeret dan 

menjatuhkan dari komputer Anda atau dengan menggunakan ikon di toolbar. 

 
 

 

"Aset Impor..." memungkinkan Anda untuk memilih satu atau lebih gambar dari 

komputer Anda sementara "Download Asset..." menampilkan dialog yang sama 

seperti pada tampilan Mockups untuk memasukkan URL gambar atau mencari 

gambar dari Flickr. 
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Note: Assets are limited to 20 Megabytes per file for performance reasons. 

Setelah menambahkan gambar, Anda dapat melihatnya sebagai thumbnail atau 

daftar, serta di Tampilan Kisi Gambar Mini. 

 

Panel Properties di sebelah kanan menunjukkan dimensi piksel dari gambar yang 

dipilih dan memungkinkan Anda memasukkan catatan tentangnya. Bagian bawah 

panel menunjukkan maket mana (jika ada) gambar yang digunakan. Ini dapat 

digunakan untuk mengelola gambar untuk melihat apakah Anda dapat 

menghapus yang tidak digunakan, misalnya. Mengklik nama mockup akan 

membawa Anda ke mockup itu di tampilan Mockup. 

 

 

Menambahkan Aset Non-Gambar 
Anda juga dapat menyimpan jenis file lain dalam proyek Anda yang tidak akan 

digunakan dalam mockup Anda, seperti dokumen persyaratan, file Photoshop 

atau Illustrator, PDF, atau file lain yang terkait dengan proyek. Kami 

menyebutnya "aset non-gambar" dan dapat ditambahkan ke project Anda 

dengan menyeretnya ke tampilan Aset, sama seperti gambar. Jenis file umum 

(zip, pdf, doc, dll.) akan ditampilkan dengan logo yang sesuai, seperti yang 

ditunjukkan di bawah ini. File lain akan memiliki ikon dokumen generik. 
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File-file ini tidak dapat dilihat di dalam aplikasi, tetapi mereka "dikemas" dengan 

proyek Anda, jadi jika Anda memberikan file proyek kepada orang lain, mereka 

akan dapat menyimpan file dari proyek Balsamiq ke komputer mereka 

menggunakan tombol "Simpan ke disk" atau item menu konteks. 

 

Mengelola Gambar dan Aset Lainnya 
Seperti tampilan Mockup, tampilan Aset memiliki menu konteks yang dapat Anda 

buka dengan mengklik kanan navigator atau menggunakan panah drop-down. 

Ini memungkinkan Anda mengganti nama, menghapus, memperbarui, atau 

mendownload gambar dan aset lainnya. 

 

 
 

 

Mengganti Nama Aset 

Mengganti nama aset menggunakan menu konteks akan mengubah nama aset 

dalam project Anda. Ini tidak akan memengaruhi file asli, karena aset adalah 

salinan yang telah ditambahkan ke proyek Anda. Gambar yang diganti namanya 

akan diperbarui di mockup Anda, jadi Anda tidak perlu memperbaruinya secara 

manual. 
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Menyimpan Aset dari Proyek Anda ke Komputer Anda 

Anda bisa mendapatkan aset dari proyek Anda ke komputer Anda dengan 

menggunakan opsi "Simpan ke Disk" di menu konteks, memungkinkan Anda 

untuk mengekstrak aset dari proyek Anda untuk penggunaan lain. 

 

Mengganti atau Memperbarui Aset 

"Impor Versi Baru..." Opsi menu memungkinkan Anda memilih aset baru untuk 

menggantikan aset yang dipilih. Ini berguna jika Anda ingin memperbarui 

gambar yang sudah digunakan dalam mockup Anda, misalnya. Versi baru 

kemudian akan digunakan di mana saja gambar yang dipilih digunakan. 

 

Menghapus Aset 

Anda juga dapat menggunakan menu konteks untuk menghapus aset dari 

project Anda. Sama seperti mockup Anda, menghapus akan memindahkan aset 

ke sampah, di mana Anda dapat menghapusnya secara permanen atau 

memulihkannya. Perhatikan bahwa menghapus gambar dari kanvas mockup 

tidak menghapusnya dari proyek Anda. 

 

Pilih Gambar yang Tidak Digunakan 

Opsi lain memungkinkan Anda memilih semua gambar yang tidak digunakan 

dalam mockup Anda. Siopsi tersedia di  menu Edit, seperti yang ditunjukkan di 

bawah ini: 
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Memilihnya akan membuka tampilan Aset tempat semua gambar yang tidak 

digunakan akan dipilih untuk Anda. Anda kemudian dapat menghapusnya seperti 

yang dijelaskan di atas. Ini adalah cara yang bagus untuk mengurangi ukuran file 

proyek Anda. 
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← Working with Icons Working with Markup → 

 

Menggunakan Gambar sebagai Ikon 
Anda dapat menggunakan aset gambar yang diimpor sebagai ikon. Mereka akan 

secara otomatis muncul di perpustakaan ikon, di bawah kategori Aset di bagian 

bawah. 
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← Working with Images and Assets Working with Symbols → 

 
 

Balsamiq untuk Dokumentasi Desktop 
 
 

 
 

Balsamiq untuk Dokumen Desktop > Bekerja dengan Markup 

 

Bekerja dengan Markup 
 

 

 

Markup adalah jenis komponen khusus di Perpustakaan UI yang digunakan untuk 

menambahkan anotasi, komentar, dan catatan penjelasan. 

 

Item Markup yang umum digunakan meliputi: Panah / Garis, Callout, Catatan 

Tempel, X Merah, dan Kurung Gigi Keriting. Tangkapan layar di bawah ini 

menunjukkan panel tombol Markup yang dipilih di Perpustakaan UI, dan item 

markup di halaman. 
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Mengaktifkan dan menonaktifkan Markup 
Saat Anda mengedit mockup, terkadang Anda ingin melihat seperti apa mockup 

dengan Markup nonaktif. Anda dapat melakukan ini dengan menggunakan 

tombol sakelar Tampilkan / Sembunyikan Markup di ujung kanan bilah alat. 

 

Tangkapan layar di bawah ini menunjukkan halaman sebelumnya dengan Markup 

nonaktif. 
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Beralih Markup dengan Pintasan Keyboard 
Ada pintasan keyboard untuk mengaktifkan dan menonaktifkan visibilitas. 

 

Tekan CTRL+K di Windows (CMD+K di Mac) untuk mengaktifkan dan 

menonaktifkan markup. Dalam mode presentasi Layar Penuh Anda cukup 

menekan tombol "M" (atau "K"). 

 

 

Membuat Item Markup dan Non-Markup 
Terkadang Anda ingin item Markup diperlakukan sebagai non-markup atau 

sebaliknya. Misalnya, Anda dapat menggunakan kontrol iPhone sebagai panduan 

untuk mendesain layar ponsel, tetapi Anda mungkin ingin menyembunyikan 

iPhone itu sendiri saat Anda mengekspornya dan melihatnya di perangkat 
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seluler. 

 

Jika Anda ingin membuat item Markup Non-Markup, klik kanan pada komponen 

dan pilih opsi "Do Not Treat as Markup" di menu konteks. Ini akan 

memungkinkan komponen terlihat saat sakelar visibilitas Markup diatur ke aktif 

atau nonaktif. 

 

Anda dapat menggunakan fitur "Treat As Markup / Do Not Treat As Markup" ini 

pada komponen apa pun. Jika Anda mengklik kanan pada komponen biasa, Anda 

dapat membuatnya berperilaku seperti Markup dengan memilih "Perlakukan 

sebagai markup." Ini akan disembunyikan saat Anda menonaktifkan visibilitas 

Markup. 

 

 

 

 

 

 

Mengekspor Markup ke PNG dan PDF 
Jika Anda ingin komponen Markup Anda muncul atau disembunyikan di gambar 

PNG yang diekspor atau PDF yang Diekspor, cukup alihkan visibilitas Markup 

seperti yang ditunjukkan di atas, dan Ekspor. 
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← Working with Markup Working with Site Maps → 

 
 

Balsamiq untuk Dokumentasi Desktop 
 
 

 
 

Balsamiq untuk Dokumen Desktop > Bekerja dengan Simbol 

 

Bekerja dengan Simbol 
 

 

 

Balsamiq Mockups mendukung konsep Simbol. Simbol adalah sekelompok 

kontrol yang mewakili satu bagian fungsionalitas. Ini sering digunakan untuk 

bagian antarmuka pengguna yang muncul di beberapa layar. Perangkat lunak 

lain terkadang menyebut fitur ini sebagai templat, halaman master, komponen 

khusus, atau widget. 

 

Intinya, Simbol memungkinkan Anda membuat elemen umum yang dapat 

digunakan kembali yang dapat Anda gunakan di berbagai mockup. 

 

Membuat Simbol 
Ada dua cara untuk membuat Simbol, dijelaskan di bawah ini. 

 

1. Membuat Simbol dalam Tampilan Mockup 

Membuat Simbol dalam tampilan Mockup dimulai dengan mengelompokkan 

kumpulan kontrol yang Anda inginkan untuk menjadi Simbol Anda. Anda dapat 

membuat grup baru atau menggunakan grup yang sudah Anda miliki. 
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Langkah-langkah berikut mengasumsikan Anda membuat grup baru. 

1. Pilih kontrol yang ingin Anda kelompokkan. 

 

 
 

 

2. Kelompokkan pilihan Anda (pilih Edit >Grup, klik ikon Grup di toolbar, atau 

gunakan CTRL/CMD+G). Perhatikan bahwa kontrol akan berubah warna 

kebiruan untuk menunjukkan bahwa mereka adalah grup. 

 

3. Beri nama grup. 

 

4. Klik tombol "Ubah Menjadi Simbol" di Inspektur Properti 
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Anda akan melihat bahwa pemilihan grup menjadi hijau muda. Ini berarti bahwa 

pemilihan sekarang merupakan turunan dari Simbol dan Anda dapat 

menggunakannya kembali dalam proyek Anda. 
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Tip: Once a Symbol has been created you can also add it via Quick Add using the first 

few letters of its name, just like other controls. 

Simbol baru ini akan ditampilkan dalam kategori Simbol Perpustakaan UI untuk 

semua maket dalam proyek Anda sehingga Anda dapat dengan mudah 

menambahkannya ke mockup apa pun. 

 

 

 

 

 

2. Menggunakan Tampilan Simbol 

Baru di Balsamiq Mockups 3 adalah tampilan khusus untuk membuat dan 

mengelola Simbol. Simbol yang dibuat menggunakan tampilan Mockup akan 

ditampilkan di sini, dan Anda juga dapat membuat Simbol dalam tampilan ini. 

 

Untuk masuk ke tampilan Simbol, gunakan ikon navigator dan pilih Simbol. Anda 

akan melihat Simbol yang ada dalam daftar di panel kiri. 
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Toolbar berisi dua ikon untuk membuat Simbol: satu untuk membuat satu dari 

kanvas kosong dan satu lagi untuk mengimpor. 

 

 

 

Klik ikon Perpustakaan Simbol Baru untuk membuat Perpustakaan Simbol baru. 

Tampilan Simbol menunjukkan Simbol serta wadah Perpustakaan Simbolnya. 

Dalam tampilan Simbol, akan sangat membantu untuk mengetahui perbedaannya 

sebelum membuatnya. Baca terus untuk penjelasannya. 

 

Simbol vs. Perpustakaan Simbol 

Perpustakaan Simbol adalah kumpulan Simbol individu. Ini dapat digunakan 

sebagai cara pengelompokan Simbol dengan tujuan serupa. Perpustakaan Simbol 

berguna untuk mengelola dan mengatur Simbol jika Anda memiliki banyak dari 

mereka. Jika Anda bukan pengguna berat Simbol, Anda dapat menyimpan 

semuanya dalam satu Perpustakaan Simbol (Anda selalu dapat menambahkan 

lebih banyak Perpustakaan Simbol nanti). 

 

Dalam tampilan Simbol, Simbol ditampilkan sebagai daftar bertumpuk di dalam 

Pustaka Simbolnya, seperti yang diperlihatkan bawah. 
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Note: The Symbol Library that a Symbol belongs to is ignored in the UI Library and Quick 

Add. You will see a list of all your Symbols, regardless of which Symbol Library they 

belong to. 

 

Anda dapat memilih nama Perpustakaan Simbol untuk melihat semua Simbol di 

dalamnya, atau Anda dapat memilih nama masing-masing Simbol untuk melihat 

hanya Simbol itu. 

 

Saat melihat Simbol, Anda akan melihat bilah mengambang kecil yang 

menunjukkan jalur breadcrumb ke Perpustakaan Simbol. Jika Anda memiliki grup 

dalam Simbol Anda, bilah breadcrumb akan membantu Anda menavigasi kembali 

keluar dari grup. 

 

Ikon di bagian atas daftar Simbol memungkinkan Anda untuk memilih apakah 

Anda ingin melihat Simbol lain di Perpustakaan Simbol bersama dengan Simbol 

yang dipilih atau tidak. 
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Note: You can add controls to the Symbol Library itself, but these controls will not be 

shown when the Symbols are used in your mockups. Adding controls such as sticky 

notes to your Symbol Libraries can be useful for making notes about them that don't 

need to be shown in the UI. 

Membuat Simbol dalam Tampilan Simbol 

Membuat Simbol dalam tampilan Simbol mirip dengan membuat Simbol dalam 

tampilan Mockup, kecuali bahwa Anda tidak perlu mengelompokkannya. Kontrol 

apa pun yang Anda tambahkan ke Simbol segera menjadi bagian darinya. 

 

Seperti dijelaskan di atas, Anda dapat menambahkan Simbol baru ke 

Perpustakaan Simbol yang ada atau di dalam yang baru. Untuk membuat Simbol 

baru, klik ikon '+' di sebelah kanan Perpustakaan Simbol. Ini akan membuat Simbol 

baru di dalam Perpustakaan Simbol itu (disebut "Simbol Baru", misalnya). 

 

Saat Anda membuat Pustaka Simbol baru, dua contoh Simbol dibuat secara 

otomatis untuk membantu Anda mempelajari tentang cara kerja Simbol. Jangan 

ragu untuk memodifikasi atau menghapusnya. 

 

 

 

Mengimpor Simbol 
Selain membuat Simbol dari awal, Anda dapat mengimpor Simbol yang dibuat di 

versi Balsamiq Mockups sebelumnya. Klik Impor Perpustakaan Simbol tombol 

untuk membuka dialog untuk mengimpor file Mockups dalam format BMML. 
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Anda juga dapat mengimpor Simbol dari menu Project > Import. 

 

 
 

 

Simbol yang diimpor akan dibuat di Perpustakaan Simbol baru. 
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Menggunakan Simbol dalam Mockup Anda 
Anda dapat menggunakan Simbol seperti kontrol lainnya di Mockup. Anda dapat 

menambahkannya dari Perpustakaan UI atau Tambahkan Cepat serta 

memindahkan dan mengaturnya dengan kontrol lain di mockup Anda. 

 

Perbedaan utama adalah bahwa properti untuk Simbol itu sendiri terbatas, mirip 

dengan kontrol dikelompokkan lainnya. 

 
 

 

Keuntungan besarnya adalah, tentu saja, bahwa setiap perubahan yang  Anda 

buat pada Simbol Anda akan diperbarui di mana pun Anda menggunakannya. 

Baca terus untuk mengetahui tentang mengedit Simbol. 

 

 

Mengedit Simbol 
Saat Anda memilih Simbol pada kanvas Mockup, Anda akan melihat dua properti 

Simbol di Inspektur Properti: Pisahkan dan Edit Sumber. 
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"Break Apart" memutuskan hubungan antara kontrol individu di dalam Simbol 

dan Simbol itu sendiri untuk contoh yang dipilih, yang berarti bahwa itu bukan 

lagi Simbol (meskipun Simbol asli tetap utuh). Setiap perubahan yang Anda buat 

pada Simbol yang pecah akan tidak diperbarui di tempat lain dan perubahan apa 

pun yang dilakukan pada Simbol tidak akan diperbarui di tempat yang telah 

dipecah. 

 

"Edit Sumber" melakukan apa yang Anda harapkan, ini membawa Anda ke 

tampilan Simbol di mana Anda dapat mengedit Simbol. Manfaat utama dari 

Simbol yang dapat digunakan kembali adalah bahwa jika Anda perlu melakukan 

perubahan, Anda bisa melakukannya di satu tempat dan itu akan disebarkan ke 

semua contoh (penggunaan) dari Simbol itu. Setelah selesai mengedit Simbol, 

Anda dapat mengklik tombol "Kembali ke Maket" di kanvas. Suntingan yang 

dilakukan pada Simbol akan segera tercermin dalam maket apa pun yang 

digunakannya. 
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Tip: You can also edit a Symbol by right-clicking on it in the UI Library and selecting 

"Edit Symbol Source." 

 

 

 

 

 

Mengesampingkan Properti Simbol 
Setelah Anda membuat Simbol, Anda mungkin ingin mengubahnya sedikit setiap 

kali Anda menggunakannya. Bayangkan misalnya Simbol yang Anda buat sebagai 

halaman master atau template, yang berisi judul dan navigasi halaman web. 
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Semua halaman situs web Anda akan memiliki ukuran dan posisi font yang sama 

untuk judul, tetapi teks judul harus berbeda pada setiap halaman. Hal yang sama 

berlaku untuk halaman mana yang harus ditampilkan sebagai dipilih di bilah 

navigasi Anda. 

 

Simbol memungkinkan Anda untuk mencapai hasil ini dengan membiarkan Anda 

mengganti properti Simbol tertentu setiap kali Anda menggunakan Simbol. 

Untuk melakukannya, mulailah dengan mengklik dua kali pada simbol untuk 

"memasukkannya". Meskipun pengalaman ini sangat mirip dengan mengedit 

konten grup, Anda akan melihat bahwa Mockups 3 memberi tahu Anda bahwa 

apa yang Anda lakukan benar-benar mengesampingkan beberapa properti 

Simbol. 
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Pada titik ini, Anda dapat memanipulasi setiap kontrol di dalam simbol sesuka 

hati, seolah-olah Anda sedang mengedit grup. Beberapa operasi tidak diizinkan 

saat mengganti properti simbol, seperti menambahkan, menghapus, atau 

mengelompokkan kontrol. Sebaliknya, jika Anda ingin mengedit semua contoh 

Simbol , klik tombol "Edit". 

 

Jika Anda membuat kesalahan, Anda selalu dapat membatalkan untuk kembali. 

Jika Anda ingin menghapus satu perubahan properti dan kembali ke properti 

default Simbol, Anda dapat mengklik ikon "x" hijau kecil di Inspektur Properti. 
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Anda juga dapat mengembalikan semua perubahan yang Anda buat ke instance 

Simbol sekaligus, melalui ikon "x" di Inspektur Properti yang Anda lihat saat 

memilih seluruh simbol. 

 

 

 

 

 

Menggunakan Simbol di Seluruh Proyek 
Jika Anda ingin menggunakan Simbol yang sama di beberapa proyek, Anda dapat 

menyalinnya ke proyek lain dengan menyeretnya dari satu proyek ke proyek 

lainnya. Anda juga dapat membuat proyek templat, dijelaskan dalam 
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Menggunakan Simbol dan Aset di Seluruh Proyek. 

 

Mengelola Simbol 
Selain membuat Perpustakaan Simbol dan Simbol dalam tampilan Simbol, ini juga 

merupakan tempat yang baik untuk mengelola dan mengatur Simbol Anda. 

 

Anda dapat menambahkan catatan ke Perpustakaan Simbol dan Simbol di panel 

Properti di sebelah kanan. Ketika Simbol individu dipilih, bagian bawah panel 

menunjukkan maket mana (jika ada) Simbol digunakan. Ini dapat digunakan 

untuk melihat apakah Anda dapat menghapus Simbol yang tidak digunakan, 

misalnya. Mengklik nama mockup akan membawa Anda ke mockup itu di 

tampilan Mockup. 

 

 

 
 

Mengganti Nama Simbol 

Untuk mengganti nama Simbol atau Perpustakaan Simbol, Anda dapat mengklik 
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Tip: You can hold down Shift or Control/CMD to select multiple Symbols and delete or 

move multiple Symbols at once. 

dua kali namanya di panel navigator di sebelah kiri atau menggunakan menu 

konteks. 

 

Menghapus Simbol 

Anda juga dapat menggunakan menu konteks untuk menghapus Simbol dan 

Pustaka Simbol dari proyek Anda. Dalam kasus Perpustakaan Simbol, seperti 

dengan maket dan gambar, menghapus akan memindahkannya ke tempat 

sampah, di mana Anda dapat menghapusnya secara permanen atau 

memulihkannya. Menghapus masing-masing Simbol dari Perpustakaan Simbol, 

bagaimanapun, menghapusnya secara permanen. 

 

 

Sama seperti dengan gambar, menghapus Simbol dari mockup tidak menghapus 

Simbol, hanya contoh Simbol. 

 

 

Simbol Kloning 

Kloning Simbol (juga tersedia melalui menu konteks) dapat menghemat waktu 

Anda saat membuat Simbol atau Perpustakaan Simbol yang serupa. 

 

Simbol Bergerak 

Anda dapat memindahkan Simbol individual dari satu Perpustakaan  Simbol ke 

Pustaka Simbol lainnya dengan menyeretnya di sekitar tampilan Simbol. Anda 

juga dapat menyalin Simbol dari satu proyek ke proyek lain seperti dijelaskan di 

atas. 

 

 

Berbagi Simbol Antar Proyek 
Jika Anda ingin berbagi aset antar proyek, seperti gambar logo atau 

Perpustakaan Simbol kontrol kustom,  sebaiknya buat proyek Balsamiq yang 



Halaman | 108 

 

berfungsi sebagai templat untuk proyek baru. 

 

Mulailah dengan membuat proyek baru. Tambahkan gambar, ikon, atau Simbol 

apa pun yang menurut Anda ingin tersedia untuk semua proyek Anda di masa 

mendatang. Jika Anda mendesain untuk platform tertentu (misalnya, seluler atau 

web), Anda juga dapat menambahkan kontrol seperti Browser, Window, atau 

iPhone ke wireframe pertama. Ini adalah proyek template Anda. Anda mungkin 

ingin menyimpannya dengan nama yang menyertakan kata "templat." 

 

Kemudian, kapan pun Anda ingin membuat proyek baru menggunakan template 

ini, duplikat proyek, ganti namanya, dan mulailah mengedit! 

 

Anda dapat melakukan ini agar semua proyek baru dapat dengan mudah 

memulai dengan pustaka bawaan aset yang umum digunakan. 
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← Working with Symbols Exporting Your Mockups → 

 
Home 

- Products 

-- Product 1 

-- Product 2 

- About Us\rCompany 

- Support 

- Blog 

 
 

Balsamiq untuk Dokumentasi Desktop 

 

Dokumen Balsamiq untuk Desktop > Bekerja dengan Peta Situs 

 

Bekerja dengan Peta Situs 
 

 

 

Anda bisa membuat peta situs sederhana dari kerangka teks menggunakan 

kontrol Peta Situs. 

 

Membuat Peta Situs 
Tambahkan kontrol "Peta Situs" dari Perpustakaan UI ke kanvas. 

 

Edit kontrol dengan mengklik dua kali atau memilihnya dan menekan tombol 

Enter. Edit kerangka untuk membuat hubungan induk-turunan. Setiap baris 

mewakili kotak (atau halaman/node) di peta situs Anda. Gunakan tanda hubung 

untuk mengindentasi kotak anak di bawah orang tua. Berikut contohnya: 
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Menggunakan Inspektur Properti Anda dapat menambahkan tautan ke node di 

peta dan mengubah properti teks dan orientasi peta (vertikal atau horizontal). 

 

Seperti inilah kerangka di atas dalam orientasi vertikal (default): 

 

 

 

 

... dan dalam orientasi horizontal: 
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Membuat Peta Situs Secara Otomatis 
Di sebelah opsi untuk mengubah orientasi di Inspektur Properti adalah tombol 

yang memungkinkan Anda untuk secara otomatis mengisi peta situs berdasarkan 

urutan dan struktur maket Anda di Panel Navigator. 

 

 

 

 

Setiap kali Anda mengklik proyek "Isi dari Proyek", peta situs akan diperbarui 

untuk mencerminkan struktur proyek saat ini. Jika Anda menggunakan hierarki 

mockup, mockup anak akan ditampilkan sebagai node anak di peta situs, seperti 

yang ditunjukkan di bawah ini. 
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Tautan akan ditambahkan ke setiap node di peta situs ke mockup yang sesuai 

dalam proyek Anda. 

 

 

Catatan dan Opsi 
Dukungan Pohon Tunggal: Peta Situs mengharapkan baris pertama menjadi 

induk paling atas, dan hanya satu yang bisa ada karena hanya membuat 

satu pohon. Jika Anda ingin membuat beberapa pohon, cukup tambahkan 

lebih banyak kontrol Peta Situs. 

Teks Multi-Baris: Anda dapat menggunakan \r untuk membuat 

pengembalian baris pada teks dalam kotak seperti ini: About\rUs 

Anda tidak dapat mengubah ukuran Peta Situs, tetapi jika Anda tidak dapat 

melihat seluruh peta di kanvas Anda, Anda dapat mencoba mengubah 

orientasi atau menampilkan salah satu node yang diperluas dalam Peta 

Situs terpisah, seperti yang ditunjukkan di bawah ini. 
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← Working with Symbols Exporting Your Mockups → 
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← Working with Site Maps Working with Skins (Sketch vs. Wireframe) → 

 
 

Balsamiq untuk Dokumentasi Desktop 
 
 

 
 

Balsamiq untuk Dokumen Desktop > Mengekspor Mockup Anda 

 

Mengekspor Mockup Anda 
 

 

 

Menu Ekspor berisi opsi ekspor berikut: 
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Note: Links may not work in the default Windows 8 or 10 PDF viewer. If this happens, 

you can download Adobe Acrobat or one of the many other free PDF viewers. 

 
 

 

Baca terus untuk deskripsi semua opsi atau lewati terus menggunakan tautan di 

bawah ini. 

 

Ekspor ke PDF... 

Saat ini atau semua mockup ke mockup PNG ke clipboard 

Mockup ke Proyek JSON ke BMML ZIP ... 

 

Mengekspor ke PDF 
Anda dapat mengekspor mockup dalam proyek Anda sebagai PDF, yang dapat 

berguna untuk mencetak, mengirim melalui email, mempresentasikan kepada 

klien, atau memposting secara online. Jika mockup Anda berisi tautan, ini akan 

berfungsi di PDF yang diekspor juga, yang memungkinkan Anda membuat 

prototipe klik-tayang dari desain Anda. (Untuk mempelajari selengkapnya tentang 

menautkan, lihat Menautkan Mockup Bersama.) 
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Untuk mengekspor ke PDF, pilih Project > Export to PDF... perintah menu 

(pintasan: CTRL/CMD+P). Setiap mockup akan ditampilkan pada halaman 

terpisah dari dokumen PDF. Maket akan berada dalam urutan yang sama seperti 

dalam proyek, jadi aturlah dalam urutan yang Anda inginkan sebelum 

mengekspor. 

 

Anda dapat memilih untuk mengekspor semua mockup atau subset, termasuk 

alternatif  yang telah Anda buat. 

 

Opsi ekspor PDF ditampilkan di sini. 

 

 

 

 

Setelah mengekspor, jendela pemberitahuan akan muncul untuk menunjukkan di 

mana PDF Anda disimpan. Klik pemberitahuan untuk membuka folder yang 

berisi. 
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Mengekspor Catatan Mockup 

Saat mengekspor mockup Anda ke PDF, Anda juga dapat memilih untuk 

mengekspor catatan yang telah Anda tulis di panel  catatan dengan mencentang 

kotak berlabel "Sertakan catatan mockup." 

 

Gambar yang diekspor  tidak termasuk catatan mockup. 

Cara lain untuk berbagi catatan mockup adalah dengan membagikan file proyek. 

 

 

Mengekspor ke Gambar 
Untuk menyimpan satu atau semua mockup Anda sebagai file gambar, pilih salah 

satu perintah ekspor ke PNG dari menu Ekspor. Ekspor > Mockup Saat Ini ke PNG 

... akan menyimpan mockup yang dipilih dalam format gambar PNG, sementara 

Ekspor > Semua Mockup ke PNG ... akan menyimpan semua mockup dalam 

proyek Anda sebagai file gambar terpisah. Jika Anda mencentang  opsi "Gunakan 

Latar Belakang Transparan", gambar yang diekspor akan transparan di mana pun 

kanvas ditampilkan di mockup. 

 

Pintasan untuk mengekspor mockup dan proyek ke file gambar masing-masing 

adalah CTRL / CMD + R dan CTRL / CMD + Shift + R. Mengekspor semua 

mockup juga akan menghasilkan gambar untuk setiap alternatif yang telah Anda 

buat. 

 

Anda juga dapat mengekspor subset kontrol di mockup Anda dengan 

memilihnya di kanvas dan menggunakan perintah Export Current Mockup to 

PNG. Dialog ekspor akan menanyakan apakah Anda hanya ingin mengekspor 

kontrol yang dipilih atau seluruh mockup. 
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Menyalin ke Clipboard 
Untuk menyalin mockup sebagai gambar untuk ditempelkan ke aplikasi lain, pilih 

Ekspor > Mockup ke Clipboard. 

 

 

Pencetakan 
Balsamiq Mockups tidak lagi mendukung pencetakan langsung ke printer. 

Sebagai gantinya, Anda dapat mengekspor ke PDF  dan mencetak dari penampil 

PDF. 

 

 

Mengekspor Mockup ke Proyek Lain 
Anda dapat menyalin mockup atau Simbol di seluruh proyek dengan 

menyeretnya dari satu proyek ke proyek lainnya. Perhatikan bahwa menyeret 

mockup hanya akan menyalinnya, bukan menghapusnya dari proyek asal. 

 

Metode lain adalah dengan menggunakan perintah JSON Mockup Impor/Ekspor 

di menu Project. Mengekspor ke Mockup JSON (Project > Export > Mockup ke 

JSON) akan menyalin kode Balsamiq Mockups untuk mockup yang dipilih ke 

clipboard. Untuk membuat mockup ini dalam proyek baru, beralihlah ke sana 

dan pilih "Impor Mockup JSON ..." dari menu Project > Import dan tempel kode 

yang disalin. 

 

 

Mengekspor untuk digunakan dalam versi sebelumnya 
Anda juga dapat mengekspor proyek Anda untuk digunakan dalam versi 

Balsamiq Mockups sebelumnya atau versi yang belum mendukung format file 

Balsamiq Mockups 3 BMPR. 
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← Working with Site Maps Working with Skins (Sketch vs. Wireframe) → 

 

Memilih Proyek Ekspor > ke BMML ZIP... akan menyimpan mockup Anda sebagai 

file ZIP yang berisi file BMML individual (kompatibel dengan Balsamiq Mockups 

versi 2) dan gambar dan Simbol yang disimpan dalam sub-folder aset. Anda 

kemudian dapat membuka ritsletingnya dan membuka maket dengan versi 

Balsamiq Mockups yang lebih lama. 
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← Exporting Your Mockups Importing Mockups and Symbols → 

 
 

Balsamiq untuk Dokumentasi Desktop 
 
 
 

 
 

Balsamiq untuk Dokumen Desktop > Bekerja dengan Skin (Sketch vs. Wireframe) 

 

Bekerja dengan Skin (Sketch vs. 
Wireframe) 

 

 

 

Kami tahu bahwa beberapa orang perlu beralih dari pembuatan ide dengan tim 

internal ke presentasi dengan klien atau pemangku kepentingan, dan dalam 

situasi tersebut kulit "sketsa" default dapat menghadirkan tantangan dengan 

audiens tertentu. Untuk mengatasi kebutuhan ini, kami menciptakan kulit 

"wireframe" yang memungkinkan Anda beralih dari gaya gambar tangan yang 

samar ke elemen wireframe yang lebih tajam dan bersih. 

 

Beralih dari Sketch ke Wireframe Skin 
Untuk mengganti skin, buka panel Project Info dan atur pengaturan Skin ke 

"Wireframe". 
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Fitur ini memungkinkan Anda untuk mengerjakan ide-ide awal di kulit yang 

samar, dan kemudian memilih menu untuk menukar semua kontrol Anda di kulit 

yang bersih. Semua elemen Anda, termasuk ikon akan diganti. 

 

Tangkapan layar di bawah ini menunjukkan perbandingan desain sampel 

masing-masing dalam kulit "sketsa" dan "wireframe" default. Klik untuk melihat 

gambar yang lebih besar. 

 

 

Kulit apa yang harus saya gunakan? 
Kami senang Anda bertanya ;-) Jawaban singkatnya adalah kita masih merasa 

bahwa kulit sketsa lebih banyak sesuai sebagian besar waktu saat menggunakan 

Mockup. 
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Tujuan kami dengan menambahkan kulit wireframe adalah untuk membantu 

menambah legitimasi pada Mockup Anda ketika menyajikannya kepada klien 

atau pemangku kepentingan, orang-orang yang mungkin secara sadar atau tidak 

sadar mengabaikan pemikiran dan upaya pekerjaan desain Anda hanya karena 

terlihat seperti itu dibuat sketsa di bagian belakang serbet. Kami benci jika 

semua kerja keras Anda tidak dihargai hanya karena tidak terlihat cukup 

"profesional"! 

 

Namun, saat mendesain, kulit sketsa asli masih menawarkan semua kelebihan 

yang selalu dimilikinya. Ini sengaja terlihat kasar dan tentatif, yang mendorong 

Anda, perancang, untuk mencoba banyak ide yang berbeda, untuk 

bereksperimen dan merevisi untuk menghasilkan desain terbaik. Mendesain di 

kulit wireframe dapat menyebabkan Anda terikat pada ide desain tertentu terlalu 

cepat karena terlihat "selesai", atau mungkin meminta Anda untuk 

menyempurnakan perataan, warna, atau font ketika Anda harus memikirkan alur 

kerja. 

 

Sama seperti kulit wireframe membuat desain terasa selesai, kulit sketsa 

membuat desain terasa belum selesai, yang memandu Anda untuk terus 

mengajukan pertanyaan dan mengeksplorasi. Deskripsi berikut tentang 

perbedaan antara sketsa dan prototipe juga dapat diterapkan pada kulit sketsa 

dan wireframe. 

Sumber: Bill Buxton, Membuat Sketsa Pengalaman Pengguna 
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← Exporting Your Mockups Importing Mockups and Symbols → 

Jadi, meskipun Anda dapat menggunakan kulit wireframe pada setiap fase proses 

desain, kami tidak benar-benar merekomendasikannya sebagai alternatif untuk 

kulit sketsa. Tapi, lebih sebagai tindak lanjutnya. Ini memperluas fungsionalitas 

Mockup dengan membuatnya lebih setuju dengan fase presentasi atau pitching 

pengembangan produk, lebih dari sekadar fase ideasi dan desain. 

 

Sejak awal, Balsamiq Mockups telah dioptimalkan untuk sweet spot dari fase 

ideasi proyek dan akan terus berlanjut di masa mendatang. Kami masih belum 

memiliki rencana untuk menambahkan perilaku interaksi mewah ke keluarga 

produk kami, misalnya, dan kami baik-baik saja dengan itu. 
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← Working with Skins (Sketch vs. Wireframe) The Project Info Panel → 

 
 

Balsamiq untuk Dokumentasi Desktop 
 
 

 
 

Balsamiq untuk Dokumen Desktop > Mengimpor Mockup dan Simbol 

 

Mengimpor Mockup dan Simbol 
 

 

 

Mengimpor Mockup dari Versi Sebelumnya (File BMML) 
Balsamiq Mockups 3 menggunakan format file yang berbeda dari versi 

sebelumnya. Anda dapat mengimpor mockup lama Anda dalam salah satu dari 

tiga format: 

 

1. File BMML individual 

2. Folder yang berisi file BMML (dengan gambar dan Simbol dalam sub-folder 

aset) 

3. File ZIP yang berisi file BMML (dengan atau tanpa gambar dan Simbol dalam 

sub-folder aset) 

 

Untuk mengonversi folder proyek atau file ZIP yang ada menjadi file BMPR, buka 

menu Project > Import. 
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Pilih apa yang ingin Anda impor dan file lama Anda akan diimpor dan file BMPR 

baru akan dibuat. 

 

 

Anda juga dapat menyeret file BMML ke Balsamiq Mockups 3 untuk 

mengimpornya ke proyek saat ini. 
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← Working with Skins (Sketch vs. Wireframe) The Project Info Panel → 

Mengimpor Simbol 
Jika Anda memiliki file Simbol yang dibuat dengan versi Balsamiq Mockups 

sebelumnya, Anda dapat mengimpornya ke Balsamiq Mockups 3 sebagai Simbol 

menggunakan perintah Import > BMML Symbol Libraries. Ini akan mengonversi 

grup menjadi Simbol bernama yang akan muncul di kategori Simbol 

Perpustakaan UI. 

 

 

Mengimpor Mockup dari Proyek Lain 
Cara termudah untuk memindahkan atau menyalin mockup dari satu proyek ke 

proyek lain adalah dengan hanya menyeret mockup (menggunakan panel 

navigator) dari satu proyek ke proyek lain. Anda juga dapat memilih dan 

menyalin kontrol pada kanvas di satu proyek dan menempelkannya ke kanvas di 

proyek lain. 

 

Atau, Anda dapat menyalin mockup dari satu proyek ke proyek lain 

menggunakan perintah JSON Mockup Impor/Ekspor di menu Proyek. Mengekspor 

ke Mockup JSON (Project > Export 

> Mockup to JSON) akan menyalin kode Balsamiq Mockups untuk mockup yang 

dipilih ke clipboard. Untuk membuat mockup ini dalam proyek baru, beralihlah 

ke sana dan pilih "Impor Mockup JSON ..." dari menu Project > Import dan tempel 

kode yang disalin. Namun, Gambar dan Simbol tidak akan disalin. 

 

 

Mengimpor Gambar 
Untuk mempelajari tentang mengimpor gambar, lihat Bekerja dengan Gambar. 
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← Importing Mockups and Symbols Linking Mockups Together → 

 
 

Balsamiq untuk Dokumentasi Desktop 
 

 

Balsamiq untuk Dokumen Desktop > Panel Info Proyek 

 

Panel Info Proyek 
 

 

 

Baru di Balsamiq Mockups 3 adalah kemampuan untuk menentukan pengaturan 

seluruh proyek untuk kulit, font, dan tautan dan warna seleksi. Panel Info Proyek 

berisi pengaturan ini serta area untuk menambahkan catatan tentang proyek. 

Klik ikon di sebelah ikon Property Inspector untuk mengaktifkan panel Info 

Proyek (pintasan keyboard: CTRL/CMD + ,). 
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Note: If you want to use a specific project font we recommend that you set it before you 

start creating your mockups. Changing the project font may adversely affect existing 

mockups in your project. Each font has different dimensions and proportions so 

switching fonts may cause controls to overlap or line up unevenly. Also, setting your 

project font to a variant such as "thin", "light", or "extrabold" may override font style 

settings on individual controls. 

Pengaturan ini akan diterapkan ke semua mockup dalam proyek dan akan 

disimpan dengan proyek (yaitu, mereka bertahan ketika proyek ditutup dan 

dibuka kembali atau dibagikan dengan orang lain). 

 

Untuk mempelajari selengkapnya tentang perbedaan antara kulit sketsa dan 

wireframe, lihat Bekerja dengan Skin. 

 

Font default adalah Balsamiq Sans, sama seperti di versi sebelumnya (bukan  

Comic Sans seperti yang Anda kira; meskipun sekarang Anda dapat mengaturnya 

ke sana, semua pecinta Comic Sans di luar sana!). 
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← The Project Info Panel Full Screen Presentation Mode → 

 
 

Balsamiq untuk Dokumentasi Desktop 

 

Balsamiq untuk Dokumen Desktop > Menautkan Mockup Bersama 

 

Menghubungkan Mockup Bersama 
 

 

 

Anda dapat menautkan mockup bersama untuk membuat prototipe sederhana 

untuk situs atau aplikasi perangkat lunak Anda. Ini dapat berguna untuk 

mendemonstrasikan prototipe klik-tayang atau untuk pengujian kegunaan saat 

Anda menampilkan proyek Anda dalam  mode Presentasi Layar Penuh atau 

sebagai PDF yang diekspor. 

 

Menghubungkan mockup bersama-sama semudah memilih nama mockup dari 

menu drop-down. Cukup klik pada kontrol yang mendukung penautan (sebagian 

besar melakukannya,  dan inilah solusi bagi mereka yang tidak), dan Anda akan 

melihat drop-down  "Link" di Property  Inspector (klik tautan "Show Link 

Inspector" jika Anda tidak melihatnya). 
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Note: To learn how to create links from text strings inside other controls, see our article 

on making links in text actually work. 

 
 

 

 

Untuk kontrol yang dapat memiliki beberapa target, Anda akan melihat sesuatu 

seperti ini: 

 

 

 

 

Setelah Anda memilih mockup atau halaman web untuk ditautkan dari menu 

tarik-turun, kontrol akan menampilkan ikon panah kecil di sudut kanan bawah. 

Link ke mockup akan ditampilkan sebagai panah biasa, sementara link ke 

halaman web akan ditampilkan sebagai panah dengan kotak di sekitarnya, 

seperti yang ditunjukkan di bawah ini. 
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Note: You can even link to an alternate version by using [this workaround] 

(/tutorials/tips/linktoalternates/). 

 
 

 

Menautkan ke Mockup yang Ada 
Daftar ini telah diisi sebelumnya dengan nama-nama maket lain dalam proyek. 

Pilih salah satu untuk menautkannya. 

 

 

 

Menautkan ke Mockup Baru 
Untuk menautkan ke mockup kosong yang belum Anda buat, klik "Tautkan ke 

Mockup Baru" dan mockup baru akan dibuat dan ditautkan dari kontrol yang 

dipilih. Pilih "Link to a New Duplicate of This Mockup" untuk membuat mockup 

baru dengan konten yang sama dengan mockup saat ini. Pemberitahuan akan 

ditampilkan dengan nama mockup baru. Mengklik notifikasi akan membawa 

Anda ke mockup itu. 
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Menautkan ke Halaman Web 
Anda juga dapat menautkan ke URL web, bukan mockup lainnya, untuk 

menampilkan tautan ke situs eksternal atau halaman produk. Untuk melakukan 

ini, pilih "Link to Web Address ..." opsi dari drop-down 

dan masukkan URL web di dialog yang muncul. 

 

 

 

 

 

Menggunakan Link dalam Mode Presentasi 
Setelah selesai menautkan mockup, Anda dapat masuk ke mode Presentasi Layar 

Penuh dan Anda akan dapat mengklik tautan yang Anda siapkan untuk menguji 

prototipe Anda. 

 

Dalam mode Presentasi Layar Penuh, kontrol dengan tautan akan memiliki 

hamparan merah di atasnya dan mengarahkan mouse ke atasnya akan 

menampilkan penunjuk tangan besar dengan nama file target atau halaman web 

untuk tautan (opsi ini dapat dimatikan di panel pengaturan Layar Penuh). 
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Klik tautan untuk membuka file mockup atau halaman web yang direferensikan. 

Tautan web akan terbuka di jendela browser baru. Link dengan target "Go Back 

(in Full Screen)" akan masuk ke mockup sebelumnya saat diklik (seperti yang 

ditunjukkan di sini). 
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← Linking Mockups Together Autosaving → 

 
 

Balsamiq untuk Dokumentasi Desktop 
 
 

 
 

Balsamiq untuk Dokumen Desktop > Mode Presentasi Layar Penuh 

 

Mode Presentasi Layar Penuh 
 

 

 

Mockup mencakup mode presentasi layar penuh untuk menyajikan wireframe 

Anda kepada pemangku kepentingan atau pengujian kegunaan. 

 

Untuk masuk ke mode Presentasi Layar Penuh, cukup klik ikon layar penuh di 

sudut kanan atas Mockup, atau pilih "Presentasi Layar Penuh" dari menu Lihat, 

atau cukup tekan CTRL / CMD + F. 
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Balsamiq Mockups akan diperluas untuk mengambil seluruh layar Anda, dengan 

mockup Anda berpusat di atasnya. 

 

Ikon paling kiri mengaktifkan dan menonaktifkan bilah atas. Anda dapat 

mematikannya untuk menghapus semuanya kecuali mockup (bahkan ikon akan 

hilang sampai kursor ditempatkan di atasnya), ini berguna untuk pengujian 

kegunaan ketika Anda menginginkan pengalaman yang lebih realistis. 

 

Menavigasi di antara Mockup 
Anda dapat menavigasi di antara mockup menggunakan ikon di kiri atas. Mereka 

berperilaku seperti ikon navigasi di toolbar editor. Panah atas dan bawah 

menavigasi di antara mockup Anda secara berurutan, sementara ikon yang 

diaktifkan di bawah ini memungkinkan Anda untuk melompat langsung ke 

mockup tertentu. 

 

 

Jika Anda telah membuat mockup  alternatif, menu akan muncul ketika Anda 

mouse di atas mockup, memungkinkan Anda untuk memilih dan menampilkan 

alternatif. Jika Anda melihat alternatif, namanya akan muncul dalam tanda 

kurung di sebelah nama mockup resmi. 
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Jika Anda telah membuat   tautan di antara mockup Anda, tautan tersebut akan 

dapat diklik dalam mode presentasi layar penuh. 

 

 

 

 

 

Pengaturan 
Secara default Anda juga akan melihat  penunjuk panah biru  besar di tempat 

kursor mouse biasa. Ini berguna untuk menyajikan maket Anda. Penunjuk akan 

menunjuk ke arah tengahlayar agar selalu menjauh dari mockup Anda sebanyak 

mungkin. 

 

Anda dapat mematikan panah biru besar di pengaturan layar penuh dengan 

mengklik ikon roda gigi di kanan atas untuk membuka panel pengaturan. 
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Panel pengaturan juga memiliki opsi untuk mengaktifkan dan menonaktifkan 

petunjuk tautan. Saat petunjuk tautan aktif, area yang berisi tautan akan 

ditampilkan dengan hamparan merah muda sehingga dapat dilihat dengan 

mudah. 

 

Pengaturan  Markup adalah untuk menampilkan dan menyembunyikan  elemen 

markup,   seperti Catatan Tempel, Panah, dan Info (kontrol apa pun di bawah tab 

"Markup" di Perpustakaan UI). Ini berguna jika Anda hanya ingin melihat UI Anda 

tanpa anotasi yang mengelilinginya. 

 

Pengaturan terakhir adalah mengatur tampilan untuk memperkecil  agar sesuai 

dengan mockup terbesar. Semua mockup lainnya akan diperbesar relatif 

terhadap mockup terbesar. 

 

Ada pintasan keyboard untuk setiap pengaturan, ditampilkan di sebelah nama 

pengaturan di panel. Tidak diperlukan tombol pengubah dalam mode layar 

penuh (misalnya, hanya L untuk petunjuk tautan, bukan CTRL/CMD+L) 
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Ikon info di sebelah ikon pengaturan akan membuka panel untuk melihat dan 

mengedit catatan untuk mockup yang dipilih, seperti dalam mode edit normal. 

 

Untuk keluar dari mode Presentasi Layar Penuh, tekan tombol ESC atau klik ikon 

di kanan atas sudut. 

 

 

Menyesuaikan Pemusatan Proyek Anda 
Mode Presentasi Layar Penuh memusatkan seluruh proyek Anda berdasarkan 

mockup yang tertinggi, dan mockup yang terluas. Meskipun ini biasanya 

menghasilkan presentasi yang terpusat (dan yang fokusnya tidak melompat-

lompat), jika Anda memiliki mockup yang jauh lebih besar daripada mockup 

Anda yang lain, itu dapat mengakibatkan proyek Anda berada di luar pusat, atau 

didorong ke bagian atas layar. 

 

Di  panel Pengaturan, Anda akan menemukan tautan yang disebut Aturan 

Pemusatan Proyek. 

 

 

 

Mengklik tautan itu akan membuka jendela yang memberi Anda gambaran 

umum tentang ukuran semua mockup dalam proyek Anda. Ini akan 

menunjukkan kepada Anda maket terpanjang dan terluas dalam proyek, dan 

ukuran efektif mereka membuat proyek Anda secara keseluruhan. Mockup 
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terpanjang akan memiliki lebar berwarna merah, sedangkan mockup tertinggi 

akan memiliki tinggi berwarna biru. Ini akan memberi Anda petunjuk tentang 

mockup apa yang menyebabkan proyek Anda salah pusat. 

 

 
 

 

Mengklik kotak centang di sebelah mockup masalah (atau mockup) akan 

mengeluarkannya dari perhitungan pemusatan (dan akan menghitung ulang 

mockup terpanjang/terluas baru, menyesuaikan ukuran proyek secara 

keseluruhan). 
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Ini harus menyelesaikan masalah pemusatan yang Anda miliki! 
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← Full Screen Presentation Mode Keeping Projects Clean and Organized → 

 
 

Balsamiq untuk Dokumentasi Desktop 
 
 

 
 

Balsamiq untuk Dokumen Desktop > Penyimpanan Otomatis 

 

Simpan otomatis 
 

 

 

Secara default, Mockups 3 for Desktop akan secara otomatis menyimpan 

perubahan yang Anda buat. Ini memastikan bahwa Anda tidak akan pernah 

kehilangan pekerjaan apa pun. 

 

Mockups 3 untuk Desktop secara otomatis menyimpan di dua tempat. Pertama, 

ia melakukan semua perubahan secara real time ke file cadangan internal. 

Kemudian setelah beberapa saat tidak aktif, Mockups 3 for Desktop akan 

melakukan perubahan pada file proyek asli Anda. Penundaan ini akan membantu 

saat Anda menyimpan ke drive atau folder jaringan. 

 

Menonaktifkan Simpan Otomatis 
Jika Anda menemukan bahwa fitur penyimpanan otomatis menyebabkan masalah 

atau alur kerja Anda lebih cocok dengan menyimpan secara manual, ini adalah 

bagaimana Anda akan menonaktifkannya. 

 

Di menu tarik-turun Project, Anda akan menemukan item bernama Auto Save 
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Every Change. Jika item menu itu memiliki tanda centang di sebelahnya, itu 

berarti penyimpanan otomatis diaktifkan. Mengkliknya akan menonaktifkan 

penyimpanan otomatis. 

 
 

 

Saat penyimpanan otomatis dinonaktifkan, perubahan Anda hanya akan 

diterapkan ke file proyek asli saat Anda menyimpannya secara manual, baik 

melalui  opsi menu Project > Save, atau dengan menggunakan pintasan keyboard 

(CMD+S di OS X dan CTRL+S di Windows). 
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Perubahan Anda masih disimpan ke file cadangan internal, dan mereka akan 

pulih secara otomatis jika Anda menutup Mockup tanpa ingat untuk 

menyimpan.Jika Anda ingin membuang perubahan apa pun yang telah Anda buat 

pada file, Anda dapat menggunakan >... item menu untuk kembali ke hal 

terakhir yang Anda simpan ke file proyek asli Anda. 

 

 

 

 

Mengaktifkan Kembali Simpan Otomatis 
Untuk mengaktifkan kembali fitur penyimpanan otomatis Mockups 3 for 

Desktop, cukup klik  item menu Project > Auto Save Every Change. Tanda centang 

akan muncul dan Anda akan melihat dialog konfirmasi di sudut kanan bawah 

kanvas. 
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← Autosaving The Local Storage Folder and Backups → 

 
 

Dokumentasi Cloud Balsamiq 
 
 

 
 

Balsamiq untuk Dokumen Desktop > Menjaga Proyek Tetap Bersih dan Teratur 

 

Menjaga Proyek Tetap Bersih dan 
Terorganisir 

 

 

 

Proyek dapat menjadi penuh dengan banyak elemen, dan kadang-kadang ada 

baiknya meluangkan waktu sejenak untuk melakukan pemeliharaan rumah. 

Membersihkan proyek Anda akan membuatnya lebih mudah dinavigasi, 

ukurannya lebih kecil, dan dengan demikian jauh lebih cepat! 

Mari kita lihat beberapa cara berbeda untuk mengoptimalkan proyek. 

Mengatur wireframes dan menggunakan hierarki 

 Panel Navigator mencantumkan semua wireframe milik proyek Anda dalam 

urutan kronologis. 

 

Anda dapat menyusun ulang sesuai keinginan (dengan menyeretnya ke atas dan 

ke bawah) dan juga menawarkan struktur hierarkis untuk mengatur wireframe 

Anda dengan lebih baik, memungkinkan Anda untuk membuat hubungan induk / 

anak di antara mereka. 
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TAB 

SHIFT 

Play 

 

Untuk menggunakannya, pilih wireframe yang Anda inginkan untuk menjadi 

anak dan tekan            Kuncinya. Wireframe anak akan ditempatkan dalam 

hierarki pohon di bawah wireframe di atasnya. 

Anda kemudian dapat menggunakan panah di sebelah kiri wireframe induk 

untuk menampilkan dan menyembunyikan wireframes di bawahnya. 

 

 

Untuk mengembalikannya ke tingkat atas, Tekan       + TAB . 

 

 

Pilih gambar/aset yang tidak digunakan 
Menggunakan   Aset dapat sangat berguna saat membuat wireframes Anda, 

tetapi karena kami menghabiskan sebagian besar waktu dalam tampilan 

Wireframes, Aset dapat dengan mudah menjadi berantakan dengan elemen yang 

tidak perlu. 

 

Dengan mengingat hal itu, kami membuat opsi yang memungkinkan Anda 

memilih semua gambar yang tidak digunakan dalam wireframe Anda. Opsi ini 

tersedia di menu Edit, seperti yang ditunjukkan di bawah ini: 
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Memilihnya akan membuka tampilan Aset tempat semua gambar yang tidak 

digunakan akan dipilih untuk Anda. Anda kemudian dapat memindahkan semua 

item ke tempat sampah dari menu konteks. 
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Note: Moving Assets to the trash does not remove them from the project. You'll need to 

use the "Empty Trash" option to delete those items permanently. 

 
 

 

 

 

Bersihkan Simbol 
Simbol adalah fitur hebat lainnya yang memungkinkan Anda membuat elemen 

umum yang dapat digunakan kembali yang Andadapat digunakan di berbagai 

wireframe. Mari kita lihat cara terbaik untuk menjaganya tetap "bersih". 
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Ketika Simbol individu dipilih, bagian bawah panel kanan menunjukkan 

wireframes mana (jika ada) Simbol digunakan. Ini adalah indikasi yang baik 

untuk menghapus Simbol yang tidak digunakan. 

 

 

 
 

Anda dapat menggunakan menu konteks untuk menghapus Simbol dan Pustaka 

Simbol dari proyek Anda. 
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SHIFT CTRL 

Note: Deleting Symbol Libraries will move them to the trash, where you can delete them 

permanently or restore them. Deleting an individual Symbol from a Symbol Library, 

however, deletes it permanently. 

 

 

 

Tips : Anda dapat  Menekan Tombol        atau          /   cmd   beberapa Simbol 

sekaligus.untuk memilih beberapa Simbol dan menghapus 

 
 

 

Kosongkan Tong Sampah 
Memindahkan item ke Tong Sampah tidak menghapusnya dari proyek. 

Menggunakan opsi "Kosongkan Sampah" adalah satu-satunya cara untuk 

menghapus item tersebut secara permanen. 

 

 

 

 

 

Langkah Ekstra: Pisahkan Proyek Anda Menjadi yang Lebih 
Kecil 
Di samping catatan, kami biasanya merekomendasikan menjaga proyek di bawah 
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100 wireframes untuk menghindari masalah kinerja. Terkadang, membagi 

proyek menjadi proyek yang lebih kecil adalah cara yang bagus dan mudah 

untuk membantu masalah kelambatan juga. 
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← Autosaving The Local Storage Folder and Backups → 

 

Kami berharap tips ini akan berguna untuk meningkatkan organisasi proyek 

Anda dan membantu dengan masalah kinerja apa pun yang mungkin Anda 

hadapi. 

 

Namun, jangan ragu untuk menghubungi dan membagikan file BMPR terkait 

dengan kami melalui support@balsamiq.com jika diperlukan. Kami siap 

membantu! :) 

 

 

mailto:support@balsamiq.com
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← Keeping Projects Clean and Organized Keyboard Shortcuts → 

 
 

Balsamiq untuk Dokumentasi Desktop 
 

Balsamiq untuk Dokumen Desktop > Folder Penyimpanan Lokal dan Cadangan 

 

Folder Penyimpanan Lokal dan Cadangan 
 

 

 

Folder penyimpanan lokal 
Balsamiq Mockups 3 for Desktop membuat folder di hard drive Anda untuk menyimpan beberapa data dan preferensi 

lokal. Ini terlihat seperti ini: 

 

 

Cara termudah untuk menemukannya adalah dengan membuka dialog "Tentang" dan mengklik tautan "Buka Folder Toko 

Lokal". 
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Note: On macOS 10.7 and Beyond: the ~/Library folder is hidden by default. You can 

access it by opening a Finder window, clicking on the "Go" menu option at the top of 

your screen, and then pressing the "alt/option" key on your keyboard. That will make 

the Library folder selectable in the dropdown menu. 

 

Note: We do not recommend moving files out of the Local Store folder. If you want to 

move a backed up file to another folder, we recommend copying the file 

(CTRL/CMD+C), and then pasting it to the destination (CTRL/CMD+V). 

Sebagai referensi, berikut adalah lokasi folder ini di berbagai sistem operasi tempat Balsamiq Mockups for Desktop 

berjalan: 
 

Pada Windows XP: C:\Documents and Settings\<username>\Application 

Data\BalsamiqMockups3.EDE15CF69E11F7F7D45B5430C7D37CC6C3545E3C.1\Toko Lokal  

Di Windows Vista dan versi lebih baru: C:\Users\ 

<nama pengguna Anda>\AppData\Roaming\BalsamiqMockups3.EDE15CF69E11F7F7D45B5430C7D37CC6C3545E3C.1\Toko 

Lokal 

Pada Mac OS X: 

/Perpustakaan/Preferensi/BalsamiqMockups3.EDE15CF69E11F7F7D45B5430C7D37CC6C3545E3C.1/Toko Lokal 

 

 

 

Memperlihatkan File Sistem di Windows 

Di Windows 7, jika Anda tidak melihat Dokumen dan Pengaturan, Anda mungkin perlu "menampilkan file sistem." Berikut 

adalah langkah-langkah untuk melakukannya: 

 

1. Buka Windows Explorer (Start+E) 

2. Pilih item menu "Atur Folder > dan opsi pencarian." 

3. Pilih tab Lihat, dan hapus centang "Sembunyikan file sistem operasi yang dilindungi." 

 

Dokumen dan Pengaturan akan muncul di bawah C:\ di Windows Explorer Anda sekarang. Jika tidak, Anda mungkin perlu 

memulai ulang. 

 

Mockups 3 untuk Desktop mencadangkan file apa pun yang Anda buka ke folder lokal. Versi lokal ini disimpan selama 

(sekitar) tujuh hari dan harus dimuat secara otomatis jika file proyek rusak. 

 

Versi Mockups 3 untuk Desktop sebelum 3.4 tidak memiliki fitur pemulihan otomatis. FAQ ini akan menunjukkan cara 

memulihkan file secara manual. 

 

Backup 
Cadangan disimpan di folder Penyimpanan Lokal dalam dua folder. 
 

Folder LocalProjects: Folder LocalProjects adalah untuk proyek yang telah Anda simpan setidaknya sekali. Kami 

menyimpan proyek di folder ini selama sekitar satu minggu sebelum menghapusnya. Folder UnsavedProjects: Folder 

UnsavedProjects adalah untuk proyek yang belum sempat Anda simpan, tetapi telah dikerjakan. Periksa di sini jika Anda 

membuka kembali Mockups 3 untuk Desktop, tetapi proyek baru Anda tidak terbuka dengannya. 

 

Memulihkan Cadangan 

Periksa  folder LocalProjects dan UnsavedProjects untuk proyek Anda. Anda mungkin harus membuka beberapa proyek 

berbeda untuk menemukan versi yang berfungsi atau terbaru. Setelah Anda menemukan dan membukanya, Pilih Project 

> Save As dan simpan file di lokasi baru. Menyimpannya memungkinkan cadangan dan versi baru file ada, yang 

membuat data Anda tetap aman! 

 


